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Welcome to TopSolid 2025!

Welcome to TopSolid 2025!

Discover the innovative brand-new features and major enhancements of TopSolid 7.19, designed to elevate your
user experience and maximize your daily productivity.

Dive deeper into these updates by visiting our e-learning platform or contact your local branch for expert guidance
tailored to your needs.

TopSolid
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What's New in TopSolid'Design 7.19

What's New in TopSolid'Design 7.19

Explore the brand-new features of the CAD applications of TopSolid 7!

User interface

Start page

Access to the FAQ of TopSolid has been added to the Help section, located at the bottom left of the start page.

Help

& Help
5 Tutorial

I What's New
M Check for Updates

F:i- Updates Notes

#/ TopSolid on the Web

B Show this page at startup

Command prediction

In the graphics area, an icon bar containing the most relevant commands is displayed either at the bottom of the
screen, above the context menu, or when an entity is selected.

You can enable the command prediction, and the number of icons predicted, in the Tools > Options >

Command Prediction command.

The display of the command prediction bar can be adjusted via the Command Prediction icon in the Home tab.

M Opticns

E%1 Command Prediction
=i General *

@ Thermes

*1 G-Code Simulation
[5) NCSimul Machine
& Start page

= Vericut

P — e -

@ Enable command prediction
Number of predicted commands:

5 -

-

— P

Display of the command prediction icon bar.

TopSolid



Themes

It is possible to configure the color of the tree borders.

What's New in TopSolid'Design 7.19

[ili] Options

aﬁ Command Prediction
E General
<1 G-Code Simulation
E Display
o Printing
7 Analysis
E Rendering
Annotations
E Assembly
& Buildings
[é Carmn Operator
[ls cAM Options
_.._EE_ Characteristics

Theme

TopSelid Classic

Colors

Low brightness mode

€, Search

—

hd Copy Rename

P POV S Y T

Color (Click to edit) Category =

Mame Value (RGE)

Elements tree

Border 128,128, 128 - (#808080) 4

Famil

L L Y

Licenses

Modified row 1128 128 253 - F

In the Licenses window, table columns can now be sorted by clicking on the column title.

| &= Licenses - TopSolid 7

Protection status

Available licenzes

One valid licenze iz available.

Description

Version Status

Type

Expiration G: Licensed to

]| TopSolid'VAR CAD (90

TopSolid'All (1)

7.19 Dizabled CLS / User (Confi... b

7.19 Valid CLS/ User 31/01/2026

R B - (R

S W A Y

PR R T arr Y

Applications can only use compatible licenses, meaning the TopSolid'Pdm Server application cannot use a
TopSolid'Pro license or a TopSolid'Steel license.

TopSolid



What's New in TopSolid'Design 7.19

PDM

New document

In the document creation window, a new search field for document types has been added, along with a Recent tab
that displays the most recently created document types.

?_, New Document

Type:
Search text

Template: il
=

%

| Recent I Commen || Advanced || Special |

=] Standard Templates
m Standard Cemponents

Part

Drafting
= g

]_ Bill of Material
{P Machining
ﬁ Work

!‘j Exploded

' Mold

G Sheet Metal Cam

ﬁ Wire
@ Wood Machining

v Electrodes

| .
.3;- Split Blocks

? Strip Design
' Rendinn

-E Azzembly
r

Assembly A ANSI Landscape
Assembly A ANSI Portrait
Assemnbly AD 15O Landscape
Assembly AD SO Portrait
Assembly A11S0 Landscape
Assembly A1 IS0 Portrait
Aszemnbly A2 150 Landscape
Assembly A2 SO Portrait
Assembly A3 [SO Landscape
Assembly A3 SO Portrait
Assembly A4 1SO Landscape
Assembly A4 SO Portrait
Assermnbly B ANSI Landscape
Assembly B ANS| Portrait
Assembly C ANSI Landscape
Assembly C ANSI Portrait
Assemnbly D ANS| Landscape
Assembly D ANSI Portrait
Assermnbly E ANSI Landscape

Project:
What's New 7.19

Assembly E ANSI Portrait

Part A ANSI Landscape
bGEl Part & ANSI Drrteait

v X ?

Document preview

The Instanced documents section has been added to the menu of the File > Document Preview command.

It defines the preview of the document created from a template.

Preview mode:

M

=" i

Document Preview

Template document preview

() From computer
© From PDM project
| LogoTopSelid “

4 Instanced documents

Size of preview:
256

Preview camera:

Perspective Camera w

Preview render mode;

scic

Preview of the document created
from the template document

TopSolid



Project tree

What's New in TopSolid'Design 7.19

The Project tree can be displayed with different columns (Description, Part Number, Author, etc.). Each column can
be sorted alphabetically and/or filtered.

The tree banner features a new icon that allows you to display or not the preview of the selected document.

What's New 7.19

MName Description

Avthor

W W

PR N What's New 7.19 WN 7.19 |

ofi References
Revisions

& 7| Templates

& . Favorites

& T Recycle bin

& 01-User Interface

E
f
|

Lol if Sl ache Sib Chara, s oo e, o

Delete

Comment

Complementary Part Number
Creation Date
Dncument%e

File Size

File Verzion

Additionally, a button to remove all active filters has been added at the bottom of the tree. This button is also
present in the project manager window and in BOM of the Parts tree.

Properties

W What's New 7.19 O *
W E W) EmE- S i ?
Mame Cri/hinn Date

Carport W16/10/2024 14:31:15 h 4
v 27/02/2023

ofu References

- __B.gvi5ior_1_sr_f -l et F . prawey

20- vafting

b o=
= & Assemblylevel
& 5 Carport 17/10/2024
& IF carport 17/10/2024

Name Contains "Carport”;Creation Date > "16/10/2024 14:31:15"

The document size analysis window is now modeless, meaning that it is possible to start another command while
waiting for the document size analysis to finish.

This window can also be accessed using the Tools > File size command.

Outlook link

A document contained in an Outlook message can now be dragged directly into the Project tree. Depending on the
document type, TopSolid will offer an import with or without conversion.

TopSolid



What's New in TopSolid'Design 7.19

Advanced management

HTTP or HTTPS protocols are used for communication between the client and the server.

The HTTPS protocol enables data encryption between the client and the server.

In addition, the Encrypt database connection option encrypts the connection between the PDM server and the SQL

instance.

4» Advanced Management

Server listening settings

Protocol: Address:

HTTP P-TO432-5TG

URL: http://P-T0482-STG:8719/pdm

Port:

g719

B Use centralized workspace

D Encrypt database connection I

=

PR

-
P -.._._AJ

Asynchronous check-in

In client/server mode, during a backup or check-in operation, files are no longer sent directly to the server; they are
sent in the background, so that you can check in immediately without having to wait for the end of the transfer.

Workspaces

In client/server mode, the Workspaces button has been added to the advanced server management window.

It allows listing the locations of the workspaces of users who have worked on the server, and the Purge context

menu command allows deleting unused files.

|45 Advanced Management

Server listening settings

Protocol: Address: Port:

HTTP P-TO482-5TG | 8719

File server
[ Check the integrity of saved files

[ Compress file transfers

URL: http://P-T0482-5TG:3719/pdm

Workspaces..,

—

8 Use centralized workspace

=

=
{4y Workspaces O X
List of workspaces (the workspace is automatically created when a user connects to the PDM server from a machine):
User Machine Location Rename...
Purge... e i Delete...
Ly
Check...
Convert...
v ?
- "
v X ?
6

TopSolid




What's New in TopSolid'Design 7.19

Security

In client/server mode, security can be defined on a folder containing a project template as well as on a project
template, allowing, for example, only the templates of a specific department or site to be made available.
Server stopping

The server can now be restarted when users are connected. Their session is no longer deleted as in previous
versions. This can be used, for example, to manage network micro-outages.

Archiving

Archived projects can now be purged, and since this deletion is permanent and irreversible, a confirmation
message is then displayed.

Missing files searching

The -SearchMissingFiles argument, followed by the destination path, can be added to the shortcut for launching
the TopSolid'Pdm Server application.

It provides a list of missing files.

Sketch

Contour

The Mono-profile option has been added in the dialog box of the Contour command. When the sketch is in
Automatic Profiles mode, only one profile is created, even if it contains self-intersecting areas.

'D Contour

Mode

‘1‘.3 UM
st 1 1

[ Lock
8 Interactive

Complementary arc

I ] Monao-profile

[ Length:

Start point:

Text

The value of the spacing for a text or a wire text can now be negative. This modification also applies to the detailing
texts in a drafting document.

Spacing = + 0.1
Spacing=-0.1

TopSolid 7



What's New in TopSolid'Design 7.19

3D sketch

The Curvature command has been added to the context menu on a spline curve. It draws a circle with the radius of
curvature on the selected point.

In addition, you can identify the position of the curve's minimum curvature using the new
Add Passing Point to Minimum Radius context-sensitive command.

In addition, the new Length Dimension command allows you to constrain the length of a curve to impose its length.

Chamfer

The chamfer command is available from the sketch operations menu.

Shadow curves

The new Shadow Curves sketch operation allows you to trace the curves delimiting the shadow zones of a part
from a direction.

v|-ﬁ|.

|Forme 1

Direction:

¢ |-Absolute 7 Axis - | db

Faces:

Face(Forme 1:Fac

¥
- — - — - — i f—

@ Colors

8 TopSolid



Shape

Drilling

What's New in TopSolid'Design 7.19

When creating a not-through tapped hole, a new button allows rounding the depth using a step instead of a
precision. This option is particularly useful for computing the depth of cooling circuit baffles.

@ standard:
Metric 150 724

[ Model

| Tapping || Hole ” Advanced
Diameter:
10,2mm
Type:

Blind

DDepth:
50,986mm

& Drilling

Round:

(] |True

A23 .1
.5?1%-133
Step’ tep
0,5mm

Mode:

Reunding:

Inferior (Step = 0,5mm)

Inferior value

Bottom type

.. "4

Drilling group

The Lightweight mode has been added to the Shape > Other Operations > Drilling Group command.

As for the Drilling command, it allows you to create drilling operations without creating the corresponding Boolean

operations.

TopSolid

»
wER |5
Sketch:
|| <[ x
Q
oo
Direction:
2 # [k
Shape to drill:
|Forme1 v|
(] Lightweight

(T W,




What's New in TopSolid'Design 7.19

Picking faces

The special input button for selecting multiple faces (root face, blend faces, faces by color, etc.) has been added to

the following commands:

* Shape > Other Operations > Hollow

* Shape > Other Operations > Transformation

* Shape > Other Operations > Deformation

Transform

() Shape to transform
© Faces to transform

Transform:

[

8 Rebuild blends

L Selection

e X 5

Blend faces...

Faces along edge paths...
Faces by color...

Faces by tangency...

Root Face...

Comparing and replacing

A new comparison mode specific to revolved shapes has been added to the Shape > Comparison > Compare,

Shape > Comparison > Replace and Replacement wizard commands from an assembly document.

It is particularly useful for comparing parts with similar topologies but of different sizes.

Shapes to compare with

Shape:

|Part2

Face on shape to compare:

| Part2:Face(106)

MNew shapes

Document:

[P Partt

Shape:

|Part1

Face on new shape:

|| Partl:Face(112)

10

[ 4l |Start Page | P Partl | [ Part2*

TopSolid



What's New in TopSolid'Design 7.19

Dialog

b
&
=] (ﬁ' Sirnilar faces
= (ﬁ' Different geometry
Face pair
Face pair
Face pair
Face pair
Face pair
Face pair
Face pair

Ly Start Page | [ Part1* | [ Pari2*

Comparison result

Face pair
Face pair
Face pair
Face pair

Face to search:

Surface

Pipe

The new By segment calculation mode corresponds to the extruded bar shape calculation algorithm used in

version 6 and allows for managing self-intersections of the section.

TopSolid

Calculation mode
() Profile
lo By segment

L Jolln]

Path:

A |Sketch 1 E:

[ Reference point on path:

11
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Imprint intersection

The new Imprint intersection command has been added to the Surface menu. It is mainly used in the FEA plugin to
prepare shapes and features two modes:

» Edge to face: computes the intersection curve(s) between two shapes and imprints the result on each shape.

» Edge to edge: identifies common edges and their limits (points), and imprints them on each shape.

v X -+ o

@ Imprint Intersection

Shape 1:
||5hapez <230>

Shape 2:
|Shape 2 <224>

Sheetmetal

Lateral faces straightening
The new All straightenable edges option automatically selects all the edges to be straightened on the part.

In this case, if no edge needs to be straightened, the operation does not become invalid; it simply "does nothing".
This new mode ensures the replaying of a sheet metal part, whatever its geometry, and is very useful for defining
generics for sheet metal components.

Sheet metals recognition

Operated property

The Operated = False property is created in parts converted as extruded bars. If the extruded bar is operated in the
assembly, this property can be modified to True, as for standard extruded bars.

Deep analysis

The new Deep analysis option detects extruded bars according to the three axes of the enclosing box. It can be
used to identify "short" extruded bars whose section is greater than their length.

This option can be time-consuming if there are many parts to analyze.

Calculations x 3: The calculation time can be up to three times longer. Therefore, it is recommended to activate this
option only when certain parts have not been recognized.

12 TopSolid
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Assembly

Extruded bars

Extruded bar kit

The new Modeling > Extruded Bar Kit command allows you to quickly position a component either at the end of an
extruded bar, or at the intersection of two extruded bars. This command starts automatically when a family, whose
generic document provides the Extruded Bar Kit function, is included.

The new Modeling > Extruded Bar Kit Creation command allows you to define the components of the extruded
bar kit and its inclusion method (at the end of an extruded bar or at the intersection of two extruded bars).

Martyr principal:
|Profi|é840xdl] léger naturel - 530mm <6

B Create frame at the origin

[ orient along extremity face

Retation angle:

o

Family:

| & Footkit “

Code:

Drivers
Offset:

50mm

B Automatic update

Example of positioning an extruded bar kit at the end of an extruded bar.

PR

@ Extruded Bar Kit ...
T

Martyr principal:
[ Profile & 40x40 Light « ~ |

Rotation angle:
e

B Reverse 1
Martyr 2: |”|||
|Profilé 8 40x40 Iéger n

4

Rotation angle:
1a0°

[CJ Reverse I|” I“

Family: N it
| 7 Bracket kit v

Code:

Example of positioning an extruded bar kit at the intersection of two extruded bars.

TopSolid 13



What's New in TopSolid'Design 7.19

Extremity frame

The new Others > Extruded Bar Extremity Frame command is accessible by right-clicking on the Frames folder
from the Entities tree. This frame element can be used to create an in-place part, or to position another part.

Entities

@ﬁ‘l’}’ [?ﬂr o
6| e 88 96 (i

9 Representations (3)

] ff2 Censtraints (12)
9 Parts (8)
[] =  Sketches (1)
@ Cameras (9)
E 4L Compass
[]e @ Seloct
[ ] = 3 Planes
D @Axes(Eﬁ Show Only
D @ Points Frames
2 Param m Show
i Styles(
[ E
9 Synchr o Emply
A Folder
Others L ;0 Informaticn...
a Aligned Frame on Sheet Metal...
A Axial Frame...
- Constrained Frame...
' Extruded Bar Extremity Frame...
&' Faces Frame...
k&

Frame as View...

ke o

These commands are also available by clicking on the Special Inputs icon in the Construction > Frames > Frame
command.

Keep trimmed side
The Keep trimmed side option has been added to the dialog box of the Modeling > Trim command.

Extruded bars to trim:

IPE Beamn 120, NF A 45-205 <

-

B Brera
Straightening mode:

MNone ~

Straighten sheetmetal lateral faces

] Keep trimmed side

[ Create folder

Vertical direction

When creating a curved extruded bar, the reference direction is now used like a vertical direction to maintain the
verticality of the extruded bar.

14 TopSolid



Healing

Family:
| ' Flat Section V|

Code:
|an>< 15 v|

++‘<ﬁ n &

Profile:

| sketch 4:5egment(1€ - | &

Reference direction:
Al e

Adjustment

Without vertical direction

Family:
| " Flat Section w |

Code:
[60x 15 v|

++‘<f9 n o

Profile:

A |Sketch 4Segment(16 v| dh

Reference direction:

A |Bbsolute 7 Axis | ol

Adjustment

With vertical direction

What's New in TopSolid'Design 7.19

The new Process healing update option, available in the Assembly section of the Options tree, allows you to

control the presence of the process when modifying the component’s position.

Indeed, when the component is moved outside the part it is operating on, its process can either be deleted (healing
option checked) or kept (healing option unchecked).

If the option is unchecked, the process will be automatically replayed when the component collides again with the

operated part.

TopSolid

Tl & 7 ?
I General

! Dimensioning Process

" .

= & Annotation B Search collisions during processes update
[/ Sketch

=] ul Assembl [CJ Process healing update

Parts operation

15
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Conversion to local part

In the assembly document, you can define options for part modifications in the document options. By default, these
options are inherited from the application options defined in Tools > Options > Assembly > Parts Operation.

Options ol Start Page | kg Assembly*
?

T e~ b3 ? |
. General Parts operation
- : I
(3 Dlmenmf:unlng () Inherited
. Annoctation a 6 "
. Tolerances PR
- Sketch Mode:
=L Assemnbly Automatic
q F

I'.& = Modify the definition docurnent:

- Shape 0 Yes, with synchronization (if possible)

() Yes, without synchronization (if possible)

I Ne

Part modification method if definition document not modifiable:

Convert to local part

Operation on part list
Mode:

Automatic

Part list modification method:

Convert to local part

In addition, the conversion operation to local part is stored under the Process operation. As a result, when a
component that has performed its processes on a part is moved to a new part, it is automatically converted to a
local part.

This allows the processes of the moved component to be performed, provided that the
Search collisions during processes update document option is enabled.

Operations 1 x
B e~ [ e 2o (7|18 S B ?

i

=} Muaodeling Stage
=

g Process 1 (Hexagon Socket Head Cap Screw 150 4762 - ME = 25 <1038=)
- | Process 1
" Conversion 1
E. Building Operlsgons
i .

W& Wizard 1 (Hexagon Socket Head Cap Screw IS0 4762 - M6 = 25 <1038>)

%Wﬂm__mm—u
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Assembly operations

The Visualization > Part and Visualization > Assembly -> Part modes are now taken into account during assembly
operations (trim, pocket, etc.).

Pti:' Cananal L E N S

Analysis

The new Analyze Process command, accessible via the context menu on a process, from the Operations tree,
allows you to copy the process with the driver values into a new temporary document that cannot be saved. When
creating a component, it will be very useful for understanding and resolving any potential issues.

Assembly kit

The Assembly Kit command was modified and you can:

* place an assembly kit between two parts with clearance;
* manage a third thickness.

TopSolid 17
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Creating automatic processes

The new Modeling > Processes > Create Automatic Processes command is used to create an operation that
groups together all the processes at the top of the Operations tree. It is unique for each document.

It is useful when the Automatic Process mode is disabled.

It allows you to replay all processes in a single operation.

Envelope block with wizard

When a component containing an envelope block was included with a wizard, a zone for entering the envelope
block dimensions has been added to the dialog box.

Division

The operation performances have been optimized. From now on, only the parts affected by the operation are
converted to local parts.

Driver consistency

The Check drivers consistency option has been added to the Advanced options section of the Modeling >
Assembly Kit and Modeling > Distribution commands.

When replacing a kit or a distribution component, it can be used to verify that the number of drivers is similar.

Management of error documents

When a document is in error, it is possible to create an in-place part, an in-place assembly, a local part or a local
assembly. This allows, for example, to repair it without basifying all operations in error. You will simply have to
reconnect them to the new part or assembly you have created.

18 TopSolid
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Building

Staircase layout

Classic landing
It is now possible to define the application mode for nosing after a flat landing.

In previous versions, the landing behaved like a tread, and the nosing was modifying its geometry.

Thanks to the new Nosing on landing option, the next flight is shifted from the nosing to keep the landing's
theoretical geometry.

Flat landing with "classic" nosing management Flat landing with Nosing on landing option

Moreover, as for the Winder and Spiral landing types, it is possible to adjust the dimension of a Classic landing type
by increasing its area of influence on one or both flights adjacent to the landing.

Stringer document templates

You can create stringers using a template document. This document defines the stringer shape to be kept from one
flight to the next.

Stringer example templates are available in the TopSolid Building library.

Sawtooth stringer type document template It is defined
by three sketches representing each part of the stair Sawtooth stringer created from document template.
flight (start, intermediate and end of the flight).

Junctions of stringers
This new option makes it possible to adjust two consecutive stringers, one by the other.

TopSolid 19
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A table appears, automatically listing, for each pair of consecutive flights, the stringer of the lower flight and the
stringer of the upper flight. The following two junction modes are available:

* Adjusted The two stringer sketches are adjusted to coincide with each other. If stringers are of the Shape
type, an additional option is provided, allowing the selection of a trimming mode.

s &

No cut: covering bottom (gray) Covering bottom stringer: covering bottom
stringer/ covering top (blue) stringer. (gray) stringer/ covered top (blue) stringer.

Covered bottom stringer: covered bottom Miter trim: a miter trim is
(gray) stringer/ covering top (blue) stringer. created between the two stringers.

* Fitting: This option is only available for Under tread type stringers. It is used to create a curved stringer
between two straight stringers.

20 TopSolid



What's New in TopSolid'Design 7.19

Advanced options
In the Advanced options section of the Staircase Layout command, two new options are available to simplify the

layout sketch:

» Simplification tolerance of tread fronts: In some cases, the edges of the treads may not be joined. This
option allows you to adapt the sketch geometry to ensure coincidences between each tread. It only modifies

the 2D sketch.

The sketch produced with a simplification tolerance The sketch produced with a simplification tolerance
finer than that of the modeling is not joined. similar to that of the modeling is not joined.

 Simplification tolerance of tread backs: This tolerance allows for the simplification of 3D tread sketches by
removing the very small segments and simplifying the tread type.

Modeling

Marking
The Marking command (for assemblies or parts) now includes the new Color advanced option, which allows
assigning a color to the edges marked by the marking operation or to the sketch of the lightweight marking.

TopSolid
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Methods
The following operations are now managed by the method document:
* Sketch modification operations
* Construction: transformations and transformation patterns
* In a part document: thickening, pattern union
* Processes: repetition generation
e Cut (extruded bars)

* The operations of the analysis stage are repeated for in-place parts created by a method

Moreover, you can add a 3D sketch as a driver for a method.

Bill of materials

Grouping options

The Group by property option has been renamed to Group by property column which groups parts when the
properties, visible or hidden, in the bill of materials, are identical.

The Compare shapes geometry option has been replaced by the Ungroup different geometries option.

When two parts are strictly identical, the shape comparison (Ungroup different geometries option) only compares
the topology of the shapes and does not take other properties into account.

Additionally, the Consider local modifications option now only applies to parts that have been locally modified (via
the Modeling > Shape > Locally Modifiable Parts command).

Search

Search fields have been added to the header of each column.

Start Page || | Carport - Flat Parts®

ID. QrY  DESCRIPTION PARTNUMEER = MAN
v | ¥%|Y v

|
=1 - 1 | Carport

1 16 | Solar Panel Full Black
. 2 2 Aluminium Hollow F‘.ectangle mLﬁﬂ‘;c‘E

|

E
L

Preview of local assemblies and parts

A specific preview is now calculated for local parts and assemblies.
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Visualization

Material side

The new Draw internal faces with a unique color mode enables fast identification of the material side of the
surface.

The color of the internal faces can be set in the Tools > Options > Themes section.

! What's New 7.19

E E‘. ﬂa L Draw internal faces with a unique color

Graphic cut

When creating a graphic cut (by plane, by profile or by box), you can choose to cut only the shapes, the shapes and

sketches, or all entities.

] Display cut
B Use shapes color
B Automatic hatching
8 Display cut edges
(O Preview cut edges
B Activate cut

Entities to cut

O Shapes

() Shapes and sketches
() All entities
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Construction

Parameters

Entities tree

It is possible to create a parameter from the context menu of a subfolder of the Parameters folder.

FEEEE R

L5

W 8 % [

New functions
Two new functions are available

¢ choose(val; test1; val1; tes

Returns val1 if val < test1, then val2 if val < test2, etc. otherwise returns valDefault

2 Representations
2 Parts

]2 Sketches

2 Cameras
i Compass

]2 Frames

]2 Planes

0 Axes

2 Points

= \} Parameters

] My Paramete

(]2 System Para My Parameters
P Styles X Delete
Explode
Folder
Boolean Parameter...
Color Parameter...
Integer Parameter...
Real Parameter...

Text Parameter...

o Lo Ee % ¥ (___u s

h.‘...n—h-__‘.—m e T e S QU SR PRI T R BT

= TR PP iy Py .

in the parameter expressions:

t2; val2; ...; valDefault)

¢ switch(cond1; val1; cond2; val2; ...; valDefault)
Returns val1 if condition cond1 is true, otherwise val2 if condition cond2 is true, otherwise returns valDefault

24
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Text parameter

The Text parameters include new functions (upper, lower, fillLeft, fillRight and replace), allowing you to modify the
character strings.

» Upper: converts all characters to uppercase

* Lower: converts all characters to lowercase

* fillLeft: adds characters on the left of the character string.

« fillRight: adds characters on the right of the character string.
* Replace: replaces one character string by another

Example:

Let two text parameters be A = "Design" and B ="7.19"

Parameter Formula Result
C =upper(A) DESIGN
D =lower(A) design
E =fillLeft(A; "TopSolid™;15) TopSolid'Design
F =fillRight(E;B;19) TopSolid'Design7.19
G =replace(F;B; "2025") TopSolid'Design2025

Surface area parameter

The Surface mode has been added to the Surface Area Parameter command. It allows the selection of a face on a
shape.

o A N i
< I

Surface Area Parameter

Description:

Face:

|| Forme 1:Face(31) - ||

Result:
243038,048104mm2

Description
The Description field has been added to all parameter creation commands.

@ Length Parameter

Marne:
i |

Description:

Total Length| w

Profile:

| [—— - FI
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The following table parameters have been added and include two data sources:

e Table Parameter

* Tabulated Integer Parameter

¢ Table Enumeration Parameter

¢ Table User Enumeration Parameter
¢ Table Text Parameter

¢ Table Material Parameter

* Table Coating Parameter

* Table Finishing Parameter

The Table Family Parameter and Table Code Parameter commands also feature two data sources.

26

>

3
2

First Source

Type of source:

Real v

Type:
Length ~

Length=1000mm

Source interpolation type:

Constant right

¥ Second Source

Type of source:

Real v

Type:
Length ~

Thickness=12mm

Source interpolation type:

Constant right
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Constrained frame

When creating a constrained frame, the positioning arrows are shifted to improve the frame's visibility.

Frame list

The Frame List command has been added to the Construction > Frames menu. It allows defining a set of frames
consisting of a main frame and auxiliary frames.

This new entity can be used as a driver in a Family document.
Point cloud
The geometry search command has been enhanced with several improvements:

Plane detection
Two new detection modes are now available:

* By sampling: detection by selecting a list of points and specifying the plane’s normal.
* By propagation: detection by selecting a list of points. This option also allows you to create a flat shape.

Search Geometries
el 1T°1 5 8 Geometry Plane
L’J . '>] Precision 2mm
B

Number of points 1 740
Selection of points from a cloud:

F |Nuage de points 1 (1) points v‘

Precision:

' 2mm

[ Create flat shape

Switch camera

TopSolid
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e57 file import

When an e57 file contains several point clouds, the dialog box for the Construction > Point Cloud command now
features a panel for selecting the clouds to be imported.

S, |

Mumber

Mumber of peints

149960

99 703

126 257

319909

ESHSHESHsflesjl <

L

302 345

g’ Information
s > —

Extruded bar detection

The new Extruded Bar Detection context command allows you to recreate extruded bars by specifying one or two

points.

An icon bar to display the enclosing box, the section and extruded bar points is provided at the top right of the

graphics area.

| + Hollow Circular Section, |51 ~

Code:
8 Use best code
4064 =

-

oint:

- |Point Clouds 1 (1) points

[J Extend

Switch camera

Refining

When editing a point cloud, the new Refining option increases the level of detail in certain areas.

28
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P

Edit Point Cloud @ Edit Point Cloud

> %@ [E W |-=28
Paint Cloud:
Point Clouds 1 -

Point Cloud:

|Point Clouds 1 v||

Peint reduction factor: . .
Point reduction factor:

W 20002 . v -

Example of 2000% refining Example of 100% refining

Constrained linear pattern

The new Tabulated mode allows you to define different values (mode, number, etc.) for each interval.

Distribution

Mode

() Simple
O Tabulated
Range Marne Comment

[Omm, 100mm| Small

[100mim, 300mm]
[300mrmn, 800mm[ | Large

[300mm, ...[ Very Large

mm

Total count:
5

[ Thickness:

Envelope block

You can serialize a constrained envelope block.
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Tools

Batch modification

The Tools > Multiple Edit command has been added to the menu.

It allows you to modify several extruded bars or component inclusions at the same time. It can also be accessed
from the top of the context menu of an extruded bar or an inclusion.

Drop-down list customization

Sketch...

Multipe Edit...

]

Selection
Show Only
Groove...

Rabbet...

Moulding...

View

Harizentally

Others

Extruded Bar 3

Edit...

Others

Profilé 8 40x40 léger nat...
In Place Edit

Hide
Delete
Attributes...

The drop-down lists tab has been added to the window of the Tools > Customize command.

It allows you to create your own drop-down lists of icons and to modify existing ones.

30

Customize

| Menus ” Shortcut keys |
Current menu: 5tG
Drag-and-drep commands between the...

Command category:

[pD sketch ~

Add commands:

| Chamfer...

‘:::' Circle...

[} Contour Wizard...
I_\ Contour...

& Define Revelution Axis...
73 Deformation...
| Fillet...

\Lme...

i Modify Grid...

[ 7 Optiens...

+ Point...

- Position Sketch...
5 Profile..,
Section...

# Sketch..

f-A‘\QETE[TZ on Curve...
Abe Text...
@Transform...

5y Trim...

Abc Wire Text...

B Display commands on document

| Contexts ” Separators H Drop-down lists
Existant drop-down lists
Add existant drop-down list:

Executable H Search ” Including
Add a search to execute

Search document:

Command name:

Custom drop-down lists

New drop-down list

r ExtrudedBars Search

@ Screws Search

00 Distribution... (Modeling)
B2 Main Trim... [Modeling)
¥ Miter Trim... (Modeling)
[ Contour... (2D Sketch)

Drag-and-drop icon:

LY«

Drag-and-drop icon:

]

Reset toclbars
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Moreover, when a document is frequently used (inclusion of a family, a method, etc.), the new Including tab allows
you create an icon to include it.

Customize O x

| Menus ” Shortcut keys |

Current menu: 5tG .
@ Display commands on document

Drag-and-drop commands between the...

| Contexts ” Separators ” Drop-down lists | Executable || Search l Including I
Command category: .
| | Add user context Add a document to include
20 Sketch w
= Document:
Skdcommands Right-click a user context to modify its icon/name, double-click to |ExtrudedBar |
" Chamfer... [} Option|  renameit. _ .
(O Circle... + Point..| = Drag-and-drop a user context to change its position. Command name:
[i Contour Wizard... :\::f':'Positio |ExtrudedE~ar |
[ Contour... 35 Profile.
L Define Revolution Axis.. [} Sectior Drag-and-drop icon:
" Deformation... # Sketch.
| Fillet... A5 Text on
\Line... Abe Text.,
1.5 Modify Grid... [A Transfo
Reset toolbars
v X ?
H
Derivation

From the Derivation operation in the Operations tree, you can change the derivation template. To do this, you must
clear the document and then use the new Edit Base Document context command to select the new derivation
template.

B v [ o] 2 RIS (B ?
= Maodeling Stage

ﬁi Fibers Management

& Material Management
Eﬁ Derivation (Del

[ Tepsclid | [ TopSolid (derived)®

cted dacumentl

T . Derivation (Deleted docum...
1 Auto Refresh
S Edit..
Clear
. Folder
& Basify
| Edit Base Dogyment...
Others i k
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Menus and keyboard shortcuts

In client/server mode, menus and shortcuts can now be managed by the administrator in the same way as
company options.

7 | W
GHDH‘IE 4 Tools

1@ &\

=1 (Admin) - TopSolid 7 (7.19.324.3-p4)

Add-ins...

Company Customizing...

Company Menu...
Company Options...
Customize...
:ﬂ Options...
1l Manage Settings...

Moreover, the Shortcut Keys tab of the Tools > Customize command now features a new button for exporting the
list of keyboard shortcuts in Excel (.CSV) format for printing.

Customize O x

| Menus ” Shortcut keys |

Command category:

|P«|| Categories ~ | 8 Show only the existing shortcut keys

Commands

|ContourWizard... (2D Sketch)] : Shift+A v| Shortcut scope:

B

| Al

Shortcut currently used by:

[ Export shortcuts L\\S ] Reset all shortcut keys
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The creation of a log file to trace events, and the choice of its location can be defined from the General section of

the Tools > Options command.

@ Opticns

emes -
<l G-Code Simulation
& Start page
E Display
& Printing
7 Analysis
E Rendering
Annotations
E’ Assembly
& Buildings
E Cam Operator
s cAM Options
EE Characteristics
Drafting
W ERP
% Mold
[ pOM
,."_'l.t Predefined Values
¥ Search
‘ Shape
¥ Sheet Metal
£ Sketch
E Translators
= Walk-through
f?) Wood
'la' Work Manager

Maximum number of commands to undo per document:

[ | 10

Maximum memory to use for undo per document:

[ | 1000 MB

Processors

MNumber of unused processors:

[ | 0

Frequently used documents

MNumber of documents to show:

[ | 5

Log file
[CJEnable creation

[ Keep files
File path:

|D:\Temp

Automation

Fory PO oy P Sy e

Materials and Textures

Optimization

When creating a texture, new options allow optimizing the size of the created documents.

Start Page | Mo Metal 01*

Bill of material
Category:

Color

Default mapping:
Auto-axis
Description:
Metal_01

Part Number:

Metal_01

Parameters

Bitrnap:

Appearance

Ch\Users\stg\Downloads\Metal_01.jpg | Image import options

Width:
3146,072308mm

Transparent color:

<unspecified>

TopSolid

[[J Lossy compression

Quality:

% | (O Optimize size for texturing
[ Auto-detect tiles

Sensitivity:

90
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Nesting (optional module)

Created document naming

You can now set the naming of documents created by nesting, according to the following two options:

* A root name, followed by a counter with a prefix (for example, IMB_n®°1, IMB_n°2, IMB_n°3).

* Document names are created based on the root name set in the template document. This allows, for
example, documents to be named according to the machining program used.

Bar nesting

Non-planar-cut straight sections
Previously, straight sections with non-planar cuts were not correctly processed by bar nesting.

In this new version, the lengths of these sections are automatically computed in the overall length mode rather than
in the extended length mode. In this particular case, the length displayed in the nesting will be Omm.

Created document naming

The bar nesting module now includes the same improvement for document naming as the nesting module (see
chapter Created document naming (on page 34)).

Drafting

Projection set

The dialog box of the Filters section has been modified. It now allows you to keep entities and ignore occurrence
properties.

ad Filters

Source document

Filter documents

Activate Filter document Keep entities IIgnorle occurrence properties
O Building O O I
| Curved Extruded Bar O ]
O Edges O ]
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Assembly level choice
The Entities mode from the View > Set command features a new section for selecting the assembly level.

.. Set (Set 1 (Carport))

Source document:

| & Carport

Representation:

Detailed Representation

() Representation

I O Entities I

Sets

Aluminium Hollow Rectangle 300 x 12

B Frame <10211>
=[]k Right side <10212»
B[ Left Side <10223>
E k" Top <10234» |

CFF aluminium U 50x 303 -

@rojectjoined parts definition
B Assembly level

(") From current level
© From top assembly
0

PR,

This feature can be used with an exception style, as shown below, and with the new Automatic Exception context
command in order to automatically localize a part in the assembly view.
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Exception style
In the view creation or editing dialog box, the Render Mode section now includes two drop-down lists that allow
you to define a primary render mode and a secondary render mode.

\

6 Render Mode

Main render mode

Inherited from style ~

Secondary render mode

Realistic w

Inherited from style
Wireframe
Shadin

T TMaterial

Attribute

() DU

The Render Mode section has also been added to the Exception Style command. It allows you to choose between
the primary and secondary render modes for the selected parts.

@ Bxception Style 1

Marne:
|Exception Style 1 |

]
e Render mode

Secondary render mode ~

You will get the view as shown below:
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Circle dimensioning

What's New in TopSolid'Design 7.19

When selecting a circle, a three-state button allows you to hook either from the center, or from one side or the

other of the circle.

F

(O —

irst gecrmetry:

,Lc‘h“ View Area:Face(18 v| h

5

econd geometry:

.Lc'h“ View Area:Face(0) v| &k

Drection:

2| v

P T T U

Crrr—

First geometry:

View Area:Face(18 « | gh

Second geometry:

2 ew restace | &

Direction:

121 d|

Automatic composite dimensions

(Crrr—

First geometry:

ViewArea:Face('IE | dh

Second geometry:

2 ew Arestacey | &

Direction:

|}||WI—|4:—|

The Ignore obround geometries option allows dimensioning only the centers of the circular arcs of obround
shapes, which helps simplify the dimensioning.

Maximum tilt:

0"

Minimurn arc:

ag®

Maximum diameter:

1000mm

Minimum diameter:

Omm

()

@ ¢ Cylindrical face detection

P

TopSolid

[ Take side axes into account
@ [ Vertices detection

[]lgnore extruded bar extremities

[] Dimension extremities for horizontal and w...

] Ignore obround geometries

(A)

Dbk Bt a ——

P Ny

— PR Y W Y vy
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(T

B < Cylindrical face detection
Maxirnurmn tilt:

o

Minimurm arc:

360

Maxirmum diameter:

1000mm

Minimurm diameter:

O
[ Take side axes into account
B " Vertices detection

[_]Ignore extruded bar extremities
[] Dimension extremities for horiz...

[ Ignere cbreund geometries

ki, |

e

A
@ ¢ Cylindrical face detection
Maximum tilt:

o

Minimum arc:

360°

Maximum diameter:

1000mm

Minimum diameter:

Omm
[T Take side axes into account
8 [ Vertices detection

() Ignore extruded bar extremities

] Ignore obround geometries

[C) Dimension extremities for horiz...

i 1 L

MW— o
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Machining process

What's New in TopSolid'Design 7.19

Information about a machining process (document name and major revision, process name, and RGB color values)

can be retrieved in a note and/or a drilling table. These properties can be defined in a dimension style or a table

style.
Tapped hole 18 | Tapped hole L Mi0 126.28mm x 128, 2Bmm | Omm Through
Tapped hole 17 Tapped hale L] M1b 100mmx 140mm Gmm "r-n:.._gr-
Tapped hole 16 | Tapped hole L M0 1&0mmx 100mm Omm Through
Tapped hole 15 | Tapped hole L M10 | 7.7Immx 128.26mm | Omm | Through ———
Tapped hole 14 | Tapped hole u M10 | 12828mm x71.72mm | Omm | Through T
Tapped hole 3 | Tapped hole L M10 G0mm x 1 00mm Omm Through
Tapped hole 12 | Tapped hole L M10 100m m x &0mm Gmm Through
Tapped hole 11 Tapped hole L] Mid F1.72mm = 71, 72mm Omm "'t'n;u_gt'
E;u**tnr'g 10 Epn”iur'g 2] 16mm 1B0mm= :]‘Emm Gmm Amm Hilj‘lr'nr'gl:'ru:r;ﬂ A
Spot Facing Spotfadng L 16mm | 180mm = 25mm mm Lmm Process 1
:;u**tnr'gﬂ :pn”iur'g C 16mm 20mm x 1 75mm Gmm Amm
Spot facing 7 Spotfadng L 16mm 20mm x 25mm Omm Lmm R=128G=255B=0
Hole g Hole 12mm 180mmx 175mm Gmm Through Hmm;m
Hole§ Hole 10.2mm 100mmx 167mm Gmm Through Hmm;m
Hoes Hole 12Zmm | 180mmx 25mm Omm | Through Process 3 R=0G=155 B=155
Hole3 Hole 12mm | 20mm x 17 5mm Omm | Through 1
Haole2 Hole 102mm | 100mmx 33mm Cmm Through m%
Hoe1 Hole L 12mm 2 0mm x TSmm Gmm Through Hmmm
Name Type Symbol | Damefer Coordonness Alfitude | work depth Document rame Machining promess RGE

TopSolid
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Automatic indexing

The Only first projection set level option has been added to the BOM Table and Automatic Indexing commands. It
allows you to not index all the subassemblies and parts located in the different levels of the assembly.

.. BOM Table (BOM Table 1)

Bill of material:

| 1) Carport - Multi-niveau V|
Set:

Main Set (Frame <10211>) v|

Filter type:

Set v

8 Only first projection set level I

(] Add line for set

First point or segment:

|Basic point V| gp

Second point:

||Basic point V| gp |

Top 236 kg
1 | R o = M 2akg
LeZice i Shikg

z Aluminiun 50 £ 303 Aumniun 150 Ly
11 EE ]
[ DECRIPTER HATERIAL Mazs
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Projected annotations

The Tolerance section has been added to the dialog box for editing a projected annotation.

It modifies the tolerance display format for the 3D document.

i ©
' |

Tolerance

Type:
Standard
S LA Standard:
P16
@I—cleTcleranceslSC 286-
Symbaol:

H7

8 Deviations display:

Tolerance difference w

Envelope

Weld symbol and difference note

The Extra Leaders section has been added to the dialog box of the Detailing > Weld Symbol command. The dialog
box of the Detailing > Difference Note command has been modified to allow multiple parts to be selected.

‘E!' Difference Note 1
Difference index:
[
Q Extra Leaders 4
Parts:
Extra Leaders:
View Area:Face[108)

View Area:Face(168)

View Area:Face(178)

Style:
Style de note de différe ~ dp

Proger —

Infe

e e s e
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Symbols

The visibility of symbols of a view is managed by a checkbox in the Entities tree. For fiber symbols, the part name
and occurrence are displayed after the symbol name.

Unfolding

Open document

Entities

B oo 155 2 (7 55 20 %
= ﬁl

2|

4 X
?

T3 Bills of Material
H T Views
= 1B) vuet
=[] Detailing
r— Dimensicns
E A Symbols

KN/ENEN

|A] symbol 1

;Q Fibers Symbol 2 ( Part 2 <174> )
&) Fibers Symbol 1( Part 1 < 166>

KN ES(EN(ES

T3 Title Blocks

The new Open Document context command allows directly opening the document included in the unfolding
document without having to select the part in the graphics area.

Work document and Work Manager

Export

Two new processes for exporting a bill of materials in CSV, Xlsx, or OptiCoupe format have been added under the

TopSolid'Interop node.

42

Start Page | g Chassis* 'ﬁ}Work 1

'& Work ”l:@' Processes

|—- Rezults ”]_ Review ‘

Selections

Available processes:

Processes to apply: {

TopSelid'Cam
TopSelid'Cam SheetMetal
TopSelid'Design
TopSelid'Drafting
TopSelid'Electrode
TopSelid'Intercp

Export to 3mf

Export to Amf

Export to Dstw
Export to Parasolid
Export to St
Export to Vrml
Export to x3d

| Exportto Xlse |

TopSelid'Intercp Acrobat

———— . Aot . Jur ey

O EHHBKBE
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2D modeling

Symbol

The Profiles option has been added to the Symbol command. As a reminder, this option transforms the symbol's
entities into many profiles, and then allows the use of the Trim command.

FEA

Static analysis (cm? solver)
When creating a new analysis, the thermal analysis option was deleted.

The commands for defining thermal loads are now available in the Analysis menu during a linear static analysis.

Translators

Selection of templates

When importing a document, the new Delete button allows you not to use templates.

| Choose the elements toimport. o x
|
'| General || Options ” Templates |

Draft template

|B|ankTemp|ate | [I]

Drawing

R I T T e P

AutoCAD

When exporting a drafting document in AutoCAD DXF/DWG format, the None option allows you to exclude images

and shaded views from the export.

Format

O DxF

O DWG

s

Werzion:

Release 2018 w

8 EBasify dimensions

@ Create blocks

Images:

Mone ~

Embedded
Linked
Linear tolerance:

o0

Sl L e — ——

kn‘..»—ﬂ.‘-.g., R T . R
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STEP import

When importing an assembly, the new Import as local parts option groups all parts in the assembly document and
avoids creating multiple documents.

Table export

A button for exporting tables in CSV format has been added to the reference and back references windows, as well
as the Parts tree of an assembly.

Assembly.A.1 - References

= [ofz| o Type: | 100types: I g v Grouping: Drag the columns cntq Searchrtext
Document Part Number Description Project: Name
b 4

w w

Bl § Assembly.A
77 Authorized Rotations.B.0
| IPE Beam 120, NF A 45-205.A.1
" IPE Beam 160, NF & 45-205.4.1
7 IPE Beam, MF A 45-205.R.0

IPE Beam 120, ...
IPE Beam 160, ...

What's Mew 7.19
TopSelid
What's New 7.19
What's New 7.19
TopSclid AFMNOR Mechanical
MW hat's 2l s 0

Point file import

When importing a point file (.xyz file) using the TopSolid7 > File > Translators > Import File into Document
command, it is possible to select the point insertion frame.

In addition, the start of the point file is displayed at the bottom of the window, and you can choose the meaning of

each column (X coordinate, Y coordinate, Radius, Angle, etc.) or ignore it.

44

lotus 49 point cloud.axyz
Coordinates

Catersian

Entity type

Paints

Length unit

Millimeter

Angle unit

Degree

Frame choice

Absolute Frame

Absolute Frame
Principal Frame of Inertia

“ 'Y coordinate

X coordinate

~ | Z coordinate
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GITF export

In the Tools > Options > Translators > gITF command, the new Maximum Texture Size section in the gITF node
allows you to define the size of exported textures. This helps reducing the generated file size.

4] Options [m] *

ooy Command Prediction Maximum Texture Size:
mu General

= 512

=] Themes

<1 G-Code Simulation

R T N P /J B I e LI U Vs ™

P Sheet Metal
£ Sketch
=] {’_{} Translators
anty Ardis export
E Blum
HE CutRite export
E3 OptiCoupe export
od) Export cutting conditions option
oy Autocad
ooy Cadenas/TraceParts
ooy Dstv
ooy E57
{’_{} General
=] oI TF

Y T VR S At e - — b S

In addition, options for exporting lights, managing exploded animations and managing faceting have been added to
the dialog box.

€ Entities Selection

(] Export cameras
8 Export lights !
: . © Representation ’ _
[:]Expcnrtvisualizatinns » B Faceting level
() Entities
Textures: Set (] Presets
Sets

Mone

Very Low ry High

Export sets as assemblies
Representations:

Design Representation
Surface tolerance

i

Exploded configuration
0 Animation

0,2mm

Angular tolerance

Animation 1
nirnation 15°

PDF export

The Export document with conversion context command now supports the Drafting Bundle documents. All the
plans in the bundle are exported as pages in the PDF document.

JT importing

PMIs contained in the documents are supported.

Obj import

The Import textures option has been added. It automatically creates Texture and Coating documents and assigns
the coating to the imported part.
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IFC Interface

Piping lines export
The size of the IFC export of a piping line with tubes and elbows has been greatly reduced. Elbows and tubes are
now transformed into polyhedrons which significantly reduces the file size.

Extruded bars export
In the IFC export settings, the new Create explicit geometry for profiles option converts profiles into arcs and lines.

IfcElementAssembly import
When the Create local parts option is checked, IfcElementAssembly entities are imported as local assemblies.

File size
During an IFC export, not meaningful zeros are now deleted, significantly reducing file size.

Moreover, similar geometries are also factorized via the IFCSHAPEREPRESENTATION entity.

DSTV Interface

When the Tools > Options > Translators > General > Display output results option is checked, an export result
file (HTML file) of several documents is created in the same folder as the DSTV files.

CADENAS

The link with the Cadenas website has been modified. The File > Translators >
Import CADENAS (Web) component command directly references the CADENAS search website and allows you to
directly include the component in TopSolid.

[ Imparter composant CADEMAS (Web)... O X
-y
+@ = | Browse 6,940 3D CAD & BIM catalogs...
<= >y 9 oy
= N & =] > Hien Q
Filter 3D Shape 2D Sketch Color Catalogs Compare wee
o £l == norelem ©@  23800-01 - Deep groove ball bearings stainless steel, DIN 626
23800-01-101503209
Searchin table ... m ¥ C(Catalog language: |[EN ¥
Preview Image Order No. width  diameter diameter Dynamic base loads... Static baseload.. Speed limit Approx.weight D
PREVIEWPERLINE BEST B [mm] O [mm] D1 [mm] TRAGZD [kN] TRAGZS [kN] DZ [U/min] GEW [kg]
Ll L L L L L L L
3 @ 23800-01-101202808 8 12 28 5100 2.380 20000 0.0197
=3 [} 23800-01-101503209 9 15 32 5580 2.850 19000 0.0293
5 "} 23800-01-101703510 10 17 35 6000 3.250 17000 0.0390

A Show compressed display (8 products)

@D @i I@ I % 3D Shape Search ] i Recommendations l = SerdtuTCpSOIilf @

Send to TopSolid

From | it

My

@ Imprint  GTC  Contact  Privacy policy  Cookie settings  TermsofUse  V12.8.1 Build 2900  ©2024 | CADENAS
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What's New in TopSolid'Virtual 7.19

Discover the latest features of TopSolid'Virtual, TopSolid 7's 3D visualization and virtual reality software!

Navigation

Focus, Drone and Walk modes

The navigation system has been completely redesigned to simplify your exploration of architectural and layout
projects. You can now choose from three modes tailored to your needs:

* Focus mode: Ideal for rotating around objects.

* Drone mode: Provides complete freedom of movement in all directions.
* Walk mode: Offers a human-height immersion for a realistic exploration of your project.

'“V ,},’/F // // E

il

¥

TopSolid user settings

A TopSolid user preset has been integrated to offer a seamless transition for users already familiar with the

TopSolid interface. This option ensures the mouse management is identical to that of TopSolid, providing a smooth
and intuitive user experience.

Settings

W Navigation

Y Collision generation

WV Language selection

W Display
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Virtual reality surface detection

The teleportation tool now detects accessible surfaces, allowing you to move over them instantly. With a single
click, you can ascend to another floor, access a rooftop, or dive to the bottom of a pool, offering fast and immersive

navigation.

Environment

New physical outdoor environment

In addition to the existing HDR lighting system, a new physical environment featuring sky, sun and clouds has been
integrated. You can now precisely adjust the position, time and orientation of your project, simulating the real
impact of sunlight. This feature not only enhances rendering quality, but also allows designers to visualize the actual
effects of shadows and sunlight on their projects.
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3D object library

Customizable 3D elements

The 3D object library is now fully customizable. You can select any 3D element from your scene and convert it into a
library item.

This makes it easy to reuse the most common 3D objects in your projects with a simple drag-and-drop operation,
without having to retexture them.

Intelligent object placement

The new intelligent placement tool automatically detects the surface on which you want to place an object. You can
now drag and drop library elements directly onto your project surfaces, with automatic physical geometry detection

for precise, effortless placement.
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What's New in TopSolid'Cam 7.19

Explore the brand-new features of the CAM applications of TopSolid 7!

Hole machining

Drilling - Additional fixtures

The Additional fixtures section has been added to the hole machining operation. All drillings located "under" the
fixtures will be considered unreachable. Its operation is now identical to that of other operations, similarly to end
milling.

Drilling - Machining ball end holes

It is now possible to machine ball end holes in the machining document. A new Ball end drill tool category is
available, with the associated generic tool.

In the methods, you can also define ball end drillings.

-

Drilling - Preview transparency

In the general options of TopSolid, as well as in the machining document options, you can now adjust the
transparency when previewing drilling geometries.
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Drilling - Geometry preview using the label

The Geometries Preview parameter is now available in the drilling operations label. Double-click on the field to
display or not the geometric preview of the operation.

Drilling - Generation of machine cycles in the drilling cycles

The new Machine cycle option forces the separation of the drilling cycle.

Drilling - Collision management with the tool holder

A new Collisions tab has been added to the drilling operation, similar to other operations managing collisions with
the tool holder.

In this tab, the new Tool holder management section allows you to ignore geometries that would collide with the
tool holder.

| Hole Machining (Drilling) : Settings
Hole Geometry Altitudes
| Fine Machining ||:| Chip Breaking |||:| Contouring |
||:| Pocketing ||:| Drilling intersections | Collisiens |
Ii = Tool holder managementl
.,

: B3mm “q‘

*¥

Lateral safe distance q""..‘
2mm ~
: 85mm L

Z =afe distance

2 mim

TopSolid 51



What's New in TopSolid'Cam 7.19

Drilling optimization - Environment management
The drilling optimization now integrates environment management.

It takes into account the environment defined beforehand, as well as the additional fixtures of the first operation in
the list.

etg SPae>  SEWN
o || 5]
=] E Program1
=] l?;' Machined Part 1
=] ; Clamping: (-) Clamp - Bent Clamp <15080=,
=] ﬁ‘ﬁ No Too
x ~ 1:Environment Activation
& 2: Spotting Drill D16 SD16
= .@@ 2: Centering/Pointing
#= Multiple geometry (40)
. 2.1: Centering/Peointing
0 2.2: Centering/Pointing gm == ==
- _. 2.3:.Center|t1§_j_f P_o_m_tl_n_g Q...-. |
BH'T 3: Foret hélicotdal D6 L35 SD6
= B ES 3: Drilling
# Multiple geometry (18)
= &S 4: Drilling
#7 Multiple geometry (8)

2 1 Bohrer D6,
= &S 5: Drilling
#= Multiple geometry (14)
BHF 5: Taraud avec allonge D8 P1,25 L35 SD8
= B &S 6: Tapping
#= Multiple geometry (14)

=8

The link between two holes from different operations correctly avoids the fixture.

Customized drilling - Absolute pass depth

The Customized drilling document’s interface has been optimized to simplify its use.

For the Descent and Machining actions, a new Altitude hole top option is available in the Distance type field. It
indicates the pass depth as an absolute value.

Cylinder and drilling analysis - Automatic cutting of undercuts

In the cylinder analysis, the new Automatic cuts command quickly cuts in half drillings of which one part cannot be
machined in the chosen direction (undercut area).

@ Sorted Drillings

=[] = WCS 1 [Origin 1| C: 0°; A: 0°] dir =0 Y=0Z=1
&-ES (1 Hole) 9=20mm

3
O
<
o

= | Mo matching methods.
= % Unreachable

Create hole stack method

Show / hide selected drillings

S TT Holet]
= | Mo matching metho,
= % Unreachable

Display
Filter

Geometry

Information
Zoom
Hole Methods

Configuration panel ﬁ
' Automatic cuts II

* ¥ ¥ v w v

=L D BB

3
o
(€
e
&
<
=

D)
%

52 TopSolid



What's New in TopSolid'Cam 7.19

Two cutting types are possible:

* All larger
* Other side larger

. Analysis of drillings and cylinders a x &, Analysis of drillings and cylinders ] X
¥ Options A |=n F; Options A |=n
Machining directicn Machining direction
||[ |-Shape1 <450>:Face(36) V| L | ||/ |-Shape1 <450>:Face(36) V| LH] |
Cut exclusion type Other side larger Cut exclusion type All larger

Radial holes Radial holes

3 cuts will be created 3 cuts will be created

Cylinder and drilling analysis - Information on entities

The display of entity types in the cylinder analysis is now more precise.

MF Analysis - Highlighting the selected element

In the machining features analysis, the selected element is highlighted in the graphics area with a red arrow.

MF Analysis - Sort criterion for hole tolerances

In the machining features analysis, the new Tolerance/Norm grouping criterion allows tapping or tolerancing
attributes to be taken into account in the sorting.

The Description column has also been integrated into the display table. It provides the hole diameter and depth,
plus additional information from the tapping or tolerancing attribute.

MF Analysis - Grouping axial and radial holes

In the machining features analysis, the new Multi axis type and Positioning diameter grouping criteria enable axial
and radial holes to be grouped together.

Its operation is similar to cylinder analysis.
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2D milling

2D milling - Toolpath limitation to machine limits (linear axes)

In end and side milling operations, the Machine limits option has been added to the Bounds tab of the Geometry
dialog box. This is a limitation in the current WCS in XYZ, collinear axes included.

2D milling - Collision detection in case of disabled tool compensation

In corrected mode, when tool compensation is disabled, the collision management has been optimized to align with
the behavior of the original mode.

Specifically, if the Take into account the finish shape option is checked, the Compensation method selected is
Corrected, the Use compensation code option is unchecked and the tool collides with the finish, the operation will
not generate a path. Instead, a warning message is displayed in the Events tree.

Side milling - Enable/Disable the perpendicular lead compensation

The Perpendicular lead compensation option has been added to the general options of TopSolid and to the
document options.

| it Options d *
End Milling

kel Machined part security shapes

?; Shopfloor Options ] Try to use topological analysis (facing, pocket) without outline curves

Tools
B |Joer pararneters 2D contouring operations
_5_ CE Full circle starting angle 0=
# |5 Cutting conditions external
(+) Dialeg configurations I Perpendicular lead compensation I

= -~

It can force or not the perpendicular lead compensation on the first movement.

Perpendicular lead compensation |_I Perpendicular lead compensation

In previous versions, it was forced by default.

This does not apply to external thread milling, hole contouring or integrated contouring.

End and side millings - XY bounding by an enclosing box

In end and side milling operations, the XY Bounding section has been added to the Bounds tab of the Geometry
dialog box.

It is now possible to bound the toolpath in XY using a box, as for the roughing operation. To do so, check the
XY Bounding box. This is a XY bounding in the current WCS. Z bounding is not possible, as it is imposed by the
starting and ending altitude of each geometry.

You can also show/hide the XY bounds preview using the new option available in the label.
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Broaching - Addition of lateral passes
The broaching operation now allows you to add lateral passes to machine grooves larger than the tool.

The width is automatically computed in new operations. In cases where the selected geometry is wireframe,
automatic computing is not possible, and the tool width is used by default.

! Broaching : Settings

Parameters Entry/Exit

Depth : 2,7382mm | Width : Bmm
Vertical passes: 1x 0,2mm + 3 x 0,81%mm + 1x 0,Tmm
Lateral passes: 1x 4mm + 2x Tmm

= Machining profiles options =

B Take into account the stock shape
B Automatic over cuts

= Groove definition

= Over-cuts

= Vertical passes

» r< w ¢ | T

= Lateral passes
Radial strategy ﬁ | Tothe right

Calculation method d Number of passes

Nbr of radial passes Width final pass
3 Ormm

Maximal radial pass

Tmm

Breaking edges - Starting at the beginning of the first segment

The new Path begins at first segment start point option allows the breaking edges operation to start at the
beginning of the first segment, when the selected profile is closed, similarly to side milling.

[[] Path begin at first segment start point .~ ' @ Path begin at first segment start point
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3D milling

3D milling - Collision strategy

To optimize collision detection, the Collision strategy parameter has been added to the Collisions and
Tool definition tabs. It allows you to select, where applicable, one of two collision management modes: Trim or
Avoid.

Avoid

Trim

3D milling - Faceting ratio and maximal facet length

The new Meshing linear tolerance ratio, Faceting angular tolerance and Maximal facet length parameters are
available for 3D operations using faceting.

They can be accessed from the Meshing parameters tab of the Properties dialog box.

l Finishing (Raster passes) : Properties

General Cellisicn management

| User set parameters Meshing parameters

Meshing linear tolerance ratio
1

[] Use own faceting angular tolerance
Faceting angular tolerance
15°

[T Use the maximal facet length
Maximal facet length

1mm

3D contouring - Taking the environment into account
The 3D contouring operation now takes the environment into account.

Local fixture has been added to the Geometry dialog box, similarly to 3D operations. A general offset is applied to
all fixtures, unlike 2D operations, where a specific offset for each fixture is possible.
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3D contouring - Starting point offset

The new Lead incremental offset parameter allows you to adjust an offset on the starting point in the 3D
contouring operation when there are several radial passes to perform on a closed profile.

The Axial first pass order type now allows you to retract at each radial pass.

| Settings ” Plunge and retract
| Collisions | Tool definition
i Geometry - J
L
Strategy =
L
% Multi depth - @
MNumber of radial passes First Offset A
10 Omm d
Radial passes step-over MNumber of axial passes

Tmm 1

Lead incremental offset

©8eH O

had

10mm

Passes order @ Axial first

Axial passes type A Along Z

Axial passes direction @ Upstairs ___,.-"" -
()% Zsteps

Constant step-over - New location for the “Trim the path at Z min” option

For Constant step-over, Superfinishing and Residual machining finishing operations, the Trim the path at Z min
parameter has been moved to the Bounds tab of the Geometry dialog box.

3D finishing - Saving colliding tool paths for residual machining

In a 3D finishing operation, the new Machine residual tool path command is accessible in the Optimization
section, by right-clicking on the machining operation.

Elaat ?:Eonstlantz . ) J

tage Finishing

= Simulate

?‘} Verify

EJ Generate G-Code..
Editing
Optimizati
Analysis

Trirmming path

Technolegical points...

rl e e

Geometry Divide tool path by tool lengths
Link movements Minimum Tool Length
Methods Machine residual tool path .'------——}-——z——---——-) ‘
Repetition
i{} Edit... &
B cur Ctrlex ~ ~ ‘\./

Constant Z finishing - Spiral machining and HSM on path

It is now possible to check both Spiral machining and HSM on path options at the same time.

Finishing - Keeping sharp cutting edges

The Geometry tab of the Constant Z, Constant step-over and Superfinishing 3D finishing operations features a
new option Produce sharp cutting edges.

It allows you to select the sharp edges to keep in order to avoid the toolpath to wrap around them.

High-speed mills - Collision point management

Collision point management is now available for high-speed mills, in both 2D and 3D operations.
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Raster passes finishing - Twin raster passes

The new Twin raster passes command is accessible in the Optimization section, by right-clicking on a 3D finishing
operation. It creates a new operation, offset by half the step value of the previous operation.

This enhancement optimizes the machining process by reducing bumps caused by sudden changes in stocks to
leave, which also helps extend tool life.
Dividing path by tool leads out - Improved tool holder management

The collision strategy algorithm has been optimized to take into account the entire shape of the tool holder, rather
than just a cylinder. This improvement allows for extended machining with shorter tools.

Residual machining - Precision improvement

The new Meshing precision parameter, available in the Settings tab, improves the search precision for elements
with material left when the result is not convincing.

However, this impacts performance, resulting in a longer computation time.
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4D milling

4D milling - Collision point management

Collision point management is now available for 4-axis operations.

5D milling

5D milling - Clearance distance before projecting on plane

When the selected clearance shape type is Local, the new Clearance distance before projecting on plane
parameter enables you to better manage the clearance distance, particularly when the safety plane is parallel to the
tool axis, or has a small angle offset.

Multi axis type .g; Five axis
| Multi Axis Settings ” Strokes ” Clearance Shapes | Local plane
| Axis Parameters | Approach and Retract |

Security type @ Local

Security shape h Local Plane

[C] Reset normal vectors at clearance plane
EJ Local security plane

[[J Automatic safety plane
Automatic safety plane margin
10mm

Plane frame

A |Basic frame

Coordinated safe plane Z

Smm

Clearance distance before projecting on plan

50mm

If the local safety plane is still not reached beyond the specified clearance distance, a perpendicular projection is
made to determine the shortest path.

5D milling - WCS creation from a dynamic frame

The new Create on dynamic frame command is available from the Operation tab, in the WCS Manager or by right-
clicking on a frame.

The dynamic frame can be moved by translation or rotation. The solutions are computed according to its position.

Blade finishing - Variable offsets
It is now possible to define variable offsets in the blade finishing operation in Blisk mode.

To do so, enter the table with point coordinates according to latitude (V) and longitude (U), as well as the offset to
apply to each point.
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@ = Variable offset 5
Latitude Lengitude Offset
0 0 Omm
0 05 0,5mm ﬁ
0 1 Omm *7
0 25 0,5mm ED;
0 Omm x
1 Omm %ﬁ)'
1 05 0,5mm @

You can export / import these values using a text file.

5D drilling - Normal visualization

Normals can now be displayed on machining paths for 5-axis drilling operations.

5D finishing - Tool center mode

In Tool center mode, the 5X Finishing command using the ModuleWorks Geodesic algorithm has been added.

5D automatic machining - Setting step-over according to tool axis

It is now possible to enter the step-over according to the tool axis rather than the scallop height (the two are linked
by a formula).

5D automatic machining - Deletion of unnecessary final passes

In the Geometry dialog box, the End passes to remove option is available under each geometry. Simply enter the
number of final passes to delete.

5D automatic machining - First pass depth

The new Respect initial axial passes option allows you to add passes to prevent an excessive first axial pass, while
respecting the defined axial pass depth as far as possible.

60 TopSolid



What's New in TopSolid'Cam 7.19

[ Respect initial axial passes B Respect initial axial passes

5D automatic machining - U and V restrictions for the faces to machine

U and V limits have been added to each selected geometry, similarly to the Sweeping operation.

5D automatic machining - Machining with the barrel mill small radius
It is now possible to choose which part of the barrel mill to use for path computing.

To do so, in the Multi Axis Settings tab of the Multi Axis dialog box, two parameters Targeted point profile section
and Minimum point profile section are available.

5D drilling - Priority direction for clearance shape movements

Three new parameters are available in the Clearance shapes tab to manage toolpath with movements on clearance
shapes (between machined geometries):

* Angle priority minimum
* Priority direction
* Priority interpolation method

[ = Use priority direction B = Use priority direction

»

Angle priority minimum

120°

Pricrity direction

;“AbsuluteZAx\s | R

Priority interpolation methode :‘inNormalradial
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Turning

Turning - Reconstruction of spline curves into segments
It is now possible to select the spline separation in the spun outline.

The Spun outline creation command includes a new Rebuild method field with two available modes:

e Lines
¢ Arcs and lines

Turning - Linking a feed rate to a face color

It is now possible to adjust the feed rate on different parts of the part to machine according to the color of the
faces.

@ Custom feedrate Creation (Custom feedrate 1) v» Finishing (Contouring) : Cutting Conditions X
W35-Rhombic L External Turn r0,4iC12

Type of feedrate

@

Color according to feedrate

| Gauges || Customized | |
£ Finishing

] Discontinuous stock

Color Feedrate Approach Distance Custom Feedrate
4 80% Omm |Custom feedrate 1 w
50% Omm =
0.05mmfrer T Feedrate slope F_#& Custom
Machining Omm 0,18mm/rev
Machining maximum | Tmm £ 2
< Rapid feed rate E’ " Rapid
= Rapid

New polygonal turning operation

The new Polygonal Turning operation allows the tool and the part to rotate in perfect synchronization to machine
flat surfaces.
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A new Polygon Turn tool type is also available. It has two categories:

 External polygon turn longitudinal
* External polygon turn plunge

Associated generic tools are also available.

Roughing - Z or X bound inversion
Bounds defined in Z or X in turn roughing operations can be inverted.

To do so, double-click on the yellow Invert limit arrow in the graphics area, or check the Invert limit option in the
Stock to leave / limits tab of the roughing operation settings.

Roughing and finishing - Modification of feed rate in discontinuous stock areas

The feed rate can be modified when the tool encounters an area with discontinuous stock that has already been
locally machined.

% Roughing (Groove Roughing) : Cutting Conditi X

L-Rectangular L External Greove L5 RI0,5 RrD,5

| Cutting conditions || Gauges ” Customized
= Roughing &
Discontinuous stock &
-
Feedrate F ~ Maximum
= 1767 1.459mm/rev
Cverlength
Tmm

Custom Feedrate

F'p-

2

Finishing - Limits in X, Z or using a window

Limits in X, Z or using a window have been added to the finishing operation.

Boost - Stock adaptation

In the operation settings, the new Adapt to stock option ensures a smoother toolpath, while reducing link
movements in certain cases.

Without stock adaptation, the toolpath follows a straight line movement parallel to the machining direction. When
the tool exits the stock, the transition is performed using a rapid link.

With stock adaptation, the path is computed according to the stock profile limited to the machining area.
Consecutive parallel passes are created to generate the toolpath.

In this case, the machining direction relative to the stock is taken into account, but not its exact value.
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) Adapt to stock B Adapt to stock

Parting off - Rapid retract

Rapid retract is now possible for all stages.

Parting off - Simplified access to parting off
The parting off primitive operation is now available from the Turning > Others > Parting off command.

A dedicated icon has also been added to the turning icon bar.

Steady - Steady opening and closing simulation

A new steady definition allows you to simulate opening and closing.

9 | ST_TRI1 0.000mm |
X1 246.000mm
X2 -391.000mm
1 311.000mm
2 172.500mm
Z3 0.000mm
Axis Turret Inf 77143
Axis Turret Sup 0.000"
c2' 0.000"
2 | stmi 0.000"
3 | sT_R2 0.000°
Positions des axes de la machine 2
ST_TR1 7.480mm
X1 246.000mm
X2 -391.000mm
z1 313.214mm
72 172 500mm
Z3 0.000mm
Axis Turret Inf 77143
Axis Turret Sup 0.000"
cz' 0.000"
ST_R1 10.003"
ST_R2 10.003"
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Scenario - Improvement of automatic synchronization

The Resolves rule conflicts dialog box, available from right-clicking in the scenario, has been enhanced. It now
offers options to resolve control rules conflicts.

Manage control rules errors
Manage spindle rotations errors
Manage driven rotations errors
Manage first error

[[] Remove constraints

8 Test all channel order

Scenario - Displaying coolant type

The machining operation’s information thumbnail now displays the operation’s defined coolant state, including the
coolant type and pressure.

Scenario - Displaying tool change

The TCP text is now displayed each time the tool changes.

Virtual jog and link movements

Link movements - Improved retraction

The automatic tool retraction movement at the end of an operation has been enhanced, particularly for
Internal turning and Parting off operations, to effectively prevent collisions.

Link movements - New criterion in the rules document

The new Workstation number criterion makes it possible to test each station number within the rules document.

Link movements and virtual jog - Machine axis motion with predefined positions

In the Machine axis motion action, it is now possible to enter predefined axis positions, similarly to movements on
coordinates.

The positions include:

* End

» Start

¢ Max. axis value
¢ Min. axis value
* WCS

* Change tool

* None

WCS - Linking a frame to several angular solutions

The process for linking a frame to multiple or all angular solutions has been simplified. Using the Ctrl or Shift key,
you can select multiple angular solutions, then apply the desired frame to the selected angular solutions.
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Tools and cutting conditions

Cutting conditions - Addition of surface finish quality

Surface finish quality has been added to cutting conditions, with three available values:

* Roughing
* Pre-finishing
* Finishing

This quality can be defined in the abacuses or groups of a cutting conditions document.

In addition, you can select the desired surface finish quality for an operation in the Cutting conditions tab, allowing
the cutting conditions to adapt accordingly.

Cutting conditions - Secondary operation parameters

The cutting conditions for secondary operations automatically generated based on a parameter of the primary
operation, such as Roughing on two, can now be edited.

Cutting conditions - Import/export of specific cutting conditions from Excel

Cutting conditions can be exported and imported in table format. Exports are performed in .csv format, while
imports support both .csv and .xls files.

Cutting conditions - Integration of EMUGE FRANKEN cutting conditions

The EMUGE FRANKEN tool manufacturer cutting conditions can now be retrieved in TopSolid.

l= End Milling : Cutting Conditions

— .
1998A.012 5 End Milling (] x
Number of Teeth: 4 Material part: 42CD4-P3.1

Request to Emuge-Franken

| Cutigncopdiing: ” £ ” Cusiopd ‘ Workpiece material identifier
3 Units
e ¥ P31
» Cutting conditions
Tool identifier

L. Abacus End Milling\Mills\HSS\ (NO MATERIAL) 1998A.012

Spindle rate tool (n) Cutting speed (vc) Tool diameter

5125rpm 103, 2m/min 12mm

Feed rate (vf) Tocth feed rate (fz) Number of tool teeth

8856mm/min 0,432mm/tocth 4

Coolant mode Tool feed rate (fz x Z)

Mone ~1,728mm/rev

— : Emuge-Franken cutting conditions...
() Tooth feed rate (fz
" Feed rate ISO output .
¥
" Machine (HAAS - VF4) v . R
L, ~ TopSclid'Cam cutting conditions
Applications

Finishing quality o

Al - | Parameters Values

Cutting cenditions documents: Ve (m/min | ft/... RO

HO MATERIAL > N (tr/min | rev/... | 2917,841tr/min

Choose an Abacus for Reading: fz (mm/tooth | .. | 0,048mm/dent
@ Abacus End Milling\Mills\HSS\ “| VE (mmamin | e | 550,225mmy/min

€ [.. = Apply selected Abacus fn (mmy/tr | in/r... | 0,192mm/tr
- = Coolant False
Save Conditions For : ap (mm - in} 12mm
1998A.012 ae (mm - in) Bmm
https://www.emuge-franken-group.com/frastechnik/fraswerkzeuge-mit-zylinderschaft/c/ff01
? |
Emuge-Franken Expert cutting Conditions v K = . |
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Cutting conditions - Modification of rapid feed rates

The rapid feed rate for each machining operation can now be edited from the Customized tab of the
Cutting conditions dialog box.

Movement is always considered rapid in simulation, verification and collision detection. By default, approach,
retract and interoperation movements are not customizable. However, an option is available to modify them.

Link movemnents rules

8 Use the link movements set in the machine

+ X

Refresh

B Reset tool holder axes if its rotations change in the interoperation by default

Customise rapid feed rate

[CJ Apply in interoperation.

Cutting conditions - Loading abacus values: entered or computed pass depth

The new Loading values from an abacus option is available under Tools > Options > CAM Options >
Cutting Conditions.

It allows you to specify whether loading of abacus cutting conditions should consider the pass depth defined in the
operation, or the value computed by TopSolid.

This feature is also useful for machining documents without stock, where the computed depth is always 0.

= End Milling : Settings
Settings u Altitudes Flunge Retract
|~|:| Centouring integrated ||$|:| Islands facing |
| High 3peed Machining | Boost || Collisicns |
Stock : Tmm Machined Stack - 0,2mm Stock Left = 0,8mm
Passes: 1x 0,8mm = 0,8mm
- - — | - - ’: viachining protiles options #
& 15 CAM Options sl acu;’f @ Tzke into account the stock sha @ Tzke into account the finish sha
F% Analyzes © Use computed Ap value @ =
& Attributes = = Overlap ¥
= () Use parameter value @y, = ~
sl Cutting Conditions ~o = Steps %
" Drillings ~
b Axial path methed i Maximal axial depth of cut
~h
Maximal axial depth i~
2rm Final axial feed r E,_ Machining
Final axial depth pass S S T
TN
Omm Final axial spind| j\ Tool Machinim
= 2737.465015rpm

TopSolid 67



What's New in TopSolid'Cam 7.19

Cutting conditions - Relay parameter in workshop documents

The new Cutting conditions parameter text parameter allows you to retrieve a parameter specific to the tool's
cutting conditions within a workshop document.

Cutting conditions - Material equivalence document referencing

Type:
General ~
Text: @ Cutting conditions parame...
Angle: © Input value rz?:m‘:: ——
~ _Vec_Roughin
0* (_) Measured value | gnng
Style: () Associative value LSl
Text Style 1 %5 Text Relay Parameter
3 Y ﬂ Cutting conditions document:
E’E Real Relay Parameter... i — — - —
A |',.:‘. Specific Cutting Conditions
':iﬁ Integer Relay Parameter... ,’
ﬁl ':3.,? Boolean Relay Parameter... ! iz
RN Creation ,f Cutting speed (vc)
3 Cutting conditions parameter... & Finishing quality:
48 Multiline Text Parameter... Roughing
Specific Cutting

Conditions

Cutting Speed (Vc)

Roughing

80m/min<«=""  |sye

A material equivalence document can now be referenced in a cutting conditions document. This feature suggests
cutting conditions adapted to the machining operation, even if the material differs from that defined in the cutting
conditions document, using material equivalences.

Cutting conditions document - PDM tool search

It is now possible to search for one or more tools using the PDM search, in addition to the left-hand explorer in the
cutting conditions document.

68

Tools affectation

Drills
U Mills
¢ Reamers
i Taps
,l .. Turnings

% Polygon Turnings

| Blades
Grinders

P R g

Description Cutting Sp
1'
2T_ECOB0E20-3C08_E... | 100m/min
” 2T_EC040E12-3C06_E... | 100m/min
” 2T_EC100E22-3CT0_E... | 100m/min
” 2T_ECCOG0E16-3C06_... [ 100m/min
” 2T_F4AS0600ADL3E_E... | 100m/min
” 2T_EC040E12-3C06_E... | 100m/min
” 2T_EC050E14-3C06_E... | 100m/min
” 2T_F4AS0600ADL3E_E... | 100m/min
” 2T_ECOB0E20-3C08_E... | 100m/min
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Cutting conditions document - Modification of the abacus order

The order of abacuses in the cutting conditions document can now be modified. This order is memorized

in a property saved in the document, allowing prioritization of one abacus over another, even if they share
compatibility, when searching for cutting conditions.

Cutting conditions document - Copying multiple abacuses

You can copy several abacuses at the same time, within the same document or across different cutting conditions
documents.

User machining cutting conditions library - Purge unused documents

The new Purge not used cutting conditions documents command is available in the context menu of the
Machining User Cutting Conditions > Cutting conditions management library.

It operates in the same way as the Purge not Used Tools command from the generic tools library
TopSolid Machining User Tools.
Tools - Tool selection when creating new operations

When creating a new operation, the new Do not mount tool for new operations except hole machining
tool selection mode is now available alongside existing Mount tool for new operations and
Do not mount tool for new operations modes.

Tools - Addition of profiles and tool compensations from the tool creation wizard

The following functions can be added or deleted directly from the tool creation wizard:

* Tool Offset

* Cutting Shape

* Collision Analysis Shape

* Cutting Revolution Shape

* Collision Analysis Revolution Shape

TopSolid
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Tools - Optimized revolution shape

The new Optimize Revolution Shape function allows simplification of the cutting or collision revolution shape

during verification.

Optimize Revolution Shape <ORS>
Occurrence name:

|ORS |

Publishings
Remove Inner Concavities From Collision Analysis Revolution Shapes:

O |Fa|se v|

Remove Inner Concavities From Cutting Revolution Shapes:

O |Fa|se v|

Optimize Revolution Shape <ORS>

OCCUFFEHCE name:
|ORS |

Puklishings
Remove Inner Concavities From Collision Analysis Revolution Shapes:

/] |True V|

Remove Inner Concavities From Cutting Revolution Shapes:

O |Fa|se v|

Optimize Revolution Shape <ORS>

Occurrence name:

|oRs |
Remove Inner Concavities From Collision Analysis Revolution Shapes:
(] |True R |
Remove Inner Concavities From Cutting Revolution Shapes:

(] |True R |
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Verification and simulation

Simulation - Coolant display

The type of coolant used in an operation can now be displayed during simulation.

Simulation - Show/hide non-programmable axes

The new Show non programmable axes option has been added to the simulation. It can be accessed from the
Show/Hide command in the context menu.

Verification - Machine representation selection

It is now possible to choose the machine representation used during verification.

Verification - Show/hide the machine

Similar to simulation, machine elements can now be displayed or hidden by clicking on the machine icon during
machine mode verification.

Verification - Selection of machine elements to import

By default, the behavior remains the same as in 7.18 version. However, hidden machine elements from the
machining document are imported into verification for collision management.

You can decide whether to import them.

#% Part settings |ﬂ General ||~‘,‘Ah Incidents ||ﬁ Compariscn ||E F

i| Post-processors S ]%% Cincem M32-V

= Hements to simulate

EE Scenario A %% Ground (not imported)

= Simulation [T Current part only B [)4% Body turret (not imported)

33 Turning r° Do not import hidden machine elements I + H"_""

ad Verify 3 [ ]49% Body main spindle (not imported)

[JDe not update the stock during threading operations (turning)

+ [lo Verify External ] e H[ %% C1 Holder (not imported)
& Wes Options B Simulate tocl-holders (milling/turning only) B[ ]45 C7 (not imparted)
) 5 WIRE Options @ Tool and attachments + [P 4

# ¥ Wood Machining H[ %% C2 Holder (not imported)

B Use realistic turning tool-heolders

[xE Characteristics H [
fB Drafting B Simulate part-helders H[ %% Mainspindle (not imported)
" ERP @ Simulate environments A5

Machine - Rotation axis without limits

Ina machine rotation axis settings, the Minimum angle and Maximum angle fields can now be empty, enabling
definition of a rotation axis with no angular limits.

Machine - Axis rotation direction

The Direction of rotation parameter has been added to the machine rotation axis settings. The available options
include:

¢ Automatic
¢ Clockwise
¢ Counter clockwise
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Methods

Methods - Pocket MF bottom area

The new Area variable gives the surface area of the pocket bottom after analyzing a pocket MF.

Methods - Simplified navigation in execution dialog boxes

Navigation in method execution dialog boxes has been improved, allowing you to go back or jump to the last page.
This functionality also applies to copied operations, whether from the same document or another.

Picking faces

Side Milling Picking face

T #® Forme 1 <460> Face(89) || 0P

Methods - Customized feed rate and stock to leave

The following element types are now available when selecting or searching for elements:

¢ Customized feed rate
¢ Customized stock to leave

The selection or search result can then be used in the operation parameters.

Methods - New “Edge” geometry type

A new Edge geometry type is available in the Picking element function, allowing you to select an edge or edge
profile when executing a method.

Methods - Finding cutting conditions document

A new Cutting conditions abacus document type has been added to the Find document function of a method
document.

The resulting document variable is only accessible using a formula. When executing the method, TopSolid searches
for the best-rated abacus in the cutting conditions document found, and applies it to the operation.

Methods - Minimum/maximum compatible tool diameter
The end milling analysis features new variables:
* Diameter of smallest compatible tool

* Diameter of largest compatible tool

They are used to specify the smallest diameter that can access all areas of the part (selected faces), or the largest
diameter that can machine at least part of the machining area.
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&

Methods - User variable update

The new Update user variable action, when integrated into a loop, retrieves the smallest or largest value of a

parameter from a set of elements.

For example, it can find the smallest vertical radius among a batch of pockets.

Methods - Tool selection during method execution

If no compatible tool is found during method execution, the tool selection dialog box is displayed, allowing you to

search for a tool in the catalog or to directly create a generic tool.

Methods - Tool search in specific libraries or projects

Tool searches can now be directed to specific libraries or projects through the Specific libraries tab.

A new Tool document library name variable has also been added. This applies to the tool definition document and

is available as a property in machining operations.

r

| Facing + Contouring + Drilling + Counter Sinking / Tool

| Filter || Sort Criteria |I Specifics libraries I

I:IAppnyilter for mounted tools

Projets or libraries:

TopSelid Machining Teols

TepSelid Machining User Teels

ECIX «

TopSolid
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Methods - Tool already in use

With the new Boolean Tool already in use variable, you can choose between several tools already in use.

Methods - Search for similar hole MF elements

When executing a method, the Find similar cylinders section has been added when selecting hole MF type
elements.

Methods - Reference to a TopSolid parameter

You can now use the Reference a TopSolid parameter variable in an operation to keep a link to the parameter.
Previously, only the parameter value at the time of method application was used.

Methods - Automatic WCS for two-part machinings

A second automatic WCS is available for two-part machinings (drilling/2 or rough turning/2).

Methods - Submethod execution optimization

If a submethod execution in the primary method is conditioned by a VB formula and the test result is false, the
action is simplified, reducing the method execution time.

Miscellaneous updates

Machined part setup - Multi-configurations for NC parts

The Add part setup configuration entity command allows you to create multiple configurations for NC parts, each
with specific environments.

When creating the machining document, one NC part per configuration in the machined part setup document is
created in separate machining stages. Their stock is linked, similarly to part repositioning.

The stock is defined in the first configuration and is also applied to subsequent configurations.

These configurations follow the chronological evolution of the part machining process, and their order is
immutable.

ﬁHome o9 Part |7 | B Assembly ¥ Py Modeling & | &9 Shap
e Edit Partt NC...

o
ov G o7 o6 | o
- wp  Grinding reserve...
C—
i g [ = 77
,ﬂ Al Edit derived Part NC... FI% Part setups
it o= we Machined Part Setup 1 configuration 2

B o 17l 2o (7[RI 20 ? | W e [ e o) 2o | [RI8) S |Fe K

o0 e &8 w8 (i1 [t
Analysis of drillings and cylinders... | ¥ O i’ ) 4]

=+ Preparation Stage
#% MNC Part Management 1 configuration 2
#% MNC Part Management 1 configuration 1

&dd partsctup conflouration.cntity we Machined Part Setup 1 configuration 1

=t Mo mendine

1
1
1
4
el =0 wev EH
o |

- (i)
B i Machined Parts ‘ - -

B oo b3 eB 3o (B 4L % ?
6] 06 #8 % [

P 1
Machined Part 2 configuration 2 [l Program
Machined Part 2 configuration 1

& Machined Part 2 cenfiguration 1

& Machined Part 2 configuration 2
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Operation editing - Default display of the last tab used

When editing a machining operation, you can automatically display the subdialog box and the last tab used.

= .__‘:l. CAM Options Creation/Edition
#o Analyzes [C] Manual Refresh
Eta;» Attributes
;‘- Cutting Conditions
tV Drillings
\1 G-Code Simulation
ke Machined part security shapes

Select a dialog te cpen while editing operation
Auto -~

Mo Dialo

Presets Dialog

;? ShopFloor Options Teol Selection Dialog

"I Teols Cutting Conditions Dialog
5% User parameters Geometry Dialog

:g 2D Milling Main Parameters Dialog

Comments Dialeg
T CImIT NUMBEr Of INTOTmMation 1aDers

-__5 Cutting conditions external
[G] Dizlog configurations |
-% Display Options -
4 Machines =

Maximum number of information labels

Geometry analysis - Default origin

If only one part origin exists in the current stage, it is now selected by default in the geometry analysis.

Presets - Automatic selection of presets

You can now automatically select a compatible preset for the created operations. If several presets are compatible
or none is found, the presets dialog box will be displayed.

Ty WSED PArarmeLers

[£ 2D Milling —
[l Cutting conditions external a v %‘.1 i

LCJ Auto select presets on changing tool

-% Display Options

-a Machines

{2 Method

tu MNC Operations Manager

te o~

[C] Auto select presets for new operations

| Ask for it

Additional save options for presets are available.

& Choose what to save in the preset ? O *
B Teol

[ Cutting Conditions @ Ae [ Y

B Material

Environment - Group definition using graphical selection

You can now group environments using graphical selection.

Programs - Renaming programs

A new Rename programs command is available in the program manager for single-channel machining documents.
It can also be accessed from the Change program command’s dialog box.

Programs are renamed in sequence order.
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Programs - Adding programs from the change program dialog box

A new Add new program command has been added to the Change program command'’s dialog box for single-
channel machining documents.

Analysis view - Display axis min/max values

The new Show max/min values option is available in the analysis window.

Normals - Differentiate normals with one or two solutions

In the normals display options, a new color has been added for normals with a single angular solution.

Security elements - Addition of the sphere

The sphere element has been added to the Security elements folder in the Entities tree. As a reminder, these
elements are created automatically in the machining document.

Default parameters - Import without deleting existing parameters

When importing a default parameter set, if TopSolid detects existing value sets with the same name, it will assign a
new name to the imported set by adding a number to the original name.

Default parameters - Saving a parameter to the current parameter set

A new Show the parameters save buttons option is available in the CAM Options > Dialog configurations section
of TopSolid's general options.

When this option is enabled, you can save a parameter locally in the current default value set, if it is modifiable. A
disk-shaped button appears next to the field when selected, provided the value differs from that of the selected set.

Hold down the Ctrl key and click on the button to select another value set to modify.

Technological points - Improved selection of element's start and end points

When a start or end point is selected, the selected path portion is now saved, ensuring correct recalculation of the
point on the correct element.

Repetition - Echoing operations in repetitions from a WCS

When creating a repetition from a WCS, the operations within this WCS are now visible in the graphics area.

Repetition - Resetting modified parameters in repeated operations

When one or more modified repeated operations are selected in the NC Operations tree, the new Repetition >
Reset to source operation command is available by right-clicking on them.

The modified values then return to the initial value of the parent operation.
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Repetition - Update stock for repetitions

The Update stock for repetitions/patterns option has been added to the operations properties. It defines the initial
state of the Update stock option for the repetitions instances.

= End Milling : Properties

General Cellisicn management I—

Compute management

Stock management

% Update stock

"!’P Update steck for repetitions/pattern

#%  Check the validity of Stack

Control points - Alignment

The new Alignment control points mode allows a machine axis to be aligned by controlling two elements (two
points, holes or tenons).

Control points - Plane measurement
The new Plane measurement control points mode allows you to measure the slope of a plane, using three points.

Points 1 and 2 determine the X+ orientation, while point 3 defines the Y+ direction.

-ﬁy\ >
z A —
{
/
Y
B
X
A

Workshop document - Extracted stock from last operation in tool sequence

In a workshop document containing the Tool change machining list chapter, the extracted stock for the tool
sequence now reflects the state after the last operation in the sequence (previously, it was the stock of the first
operation in the sequence).

Workshop document - Driven point parameter with simplified text

A new DrivenPointType parameter displays only the description of the Tool offset function, not the full text of the
offset.
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Workshop document - Displaying consecutive operations by tool

A new Consecutive machining operations by tool list has been added to the property table. It generates the list of
machinings performed by a single tool.

| Tool view Part view Operafions
Description Facing 127 44
Facing 136,20
=:u Face Mill Extended Length D63 AS0 13 SD&1 Facing 386 95
Sequence fime |['h12rr|n 0= Facing 99,07
Tofaltime |I2'h13rrln1B:
Pockef
- Description Open pocketing 8,88
Pocketing 10,64
h:l Side Mill Fretted D20 135 5020 U|:|EI'I puckefing 1071
Sequence fime |I2'h3n1n-'-: F'.uckefi.n_g 23,39
E— |[h3an6 Side Milling 88,01
ofalm J| =1
I Open pocketing 40,13
Pocket

Workshop document - Stock update color by tool

Model views displaying the stock can now display the machined faces by the operation in the same color as the tool
used, as in verification.

Tool view Part view Operafions
Description Facing 127 kb
Facing 136,20
¢u Face Mill Extended Length D63 A90 L3 5041 Facing 38695
Sequence fime Oh 12min 30s Facing 99.07
Total time Oh 13min 18s
Pocket
Description Open pocketing 8,88
N Pockefing 10,6t
Sequence fime Oh 3Imin 4s P-{JCkEﬁ.I'I.g 25,59
Total time 0h 3Imin &46s Side Milling - 8801
: - Open pocketing 4013
Pockef

Workshop document - Machine component data

Machine component data can now be retrieved in workshop documents.
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Ul - Cleaning the document

The new Clean Document command, available in the Operations tab, offers the following options.

&4 Clean Document O *

Delete unused tools

Delete cutting condition references
Delete unused WCS and origins

[ Disable cam operations

Save as archive

v X?

Ul - Display/hide toolpath points

Anew icon in the graphics area allows you to show or hide machining operations' toolpath points. These points are
the same color as the toolpath feed rate and are positioned at the extremities of the entities to go over.

Hide / Show Points ToolPath
In addition, blue points are displayed in the center of circular arcs.

Ul - Display/hide toolpath link movements
A new icon in the graphics area allows you to display or hide link movements' toolpath points.

_'_5 Hide / Show Link movements

Ul - Canceling all calculations

You can cancel the execution of the entire operation range by pressing the Esc key. Non-executed operations will
need to be re-executed.

Ul - End-of-program display

A line marking the end of a program appears in the NC Operations tree if a description is entered.

Ul - Display operation number during editing

The operation number is now displayed before the tool name in the graphics area, when editing it.
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Ul - Menu: shortcut to include a document

A new Including tab in the Customize command's menu allows you to create shortcuts to a document to be
included, contained in a library or project.

Customize
|| Menus ” Shortcut keys |

{ Current menuw: Test

1
1 Drag-and-drop commands between the ...

| Contexts || Separators ” Drop-down lists | Executable ” Search |I Including I

| Command category: i -
Add user context a document to include

| |AII Categories v|
| Document:
Add commands: Right-click a user context to modify its icon/name, double-click to | |
fi About TopSolid... (Global) rename it. _ B
:&AccesstoTopSolid'FAQ... (Global) Drag-and-drop a user context to change its position. Command name:
& Access to TopSelid'Forum... (Global) | |
U Access to TopSolid'Store... (Global)
ﬁfﬂdd—ins... (Tools) Drag-and-drop icon:
S Aute Update (Edit)
% Automation Guide... (Automation)
T ot L1 ) oS AT ey - J)

Ul - Display/hide universal machine

It is now possible to display or hide the universal machine (planes/axes, etc.) by clicking on the machine icon, as for
other machines.

Hale Machining

Hale machining is a machining process in which neither the tool nor the part rotates around a power axis. The tool
orientation is continuous, perpendicular to the machined profile.

The Hale Machining type has been added to the following operations:
* Side Milling

* Finishing (Raster passes / Morphing / Constant step-over modes)
* 3D Contouring

It can be accessed from the Multi Axis dialog box by selecting 3X + Hale Machining in the Multi axis type field.
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Wire

Wire - Verification in machine mode

Machine mode verification is now available in wire machining documents.

Wire - Cutting self-intersecting profiles

Wire cuts can be created using self-intersecting geometries, even when based on a self-intersecting profile.

&

Wire - Workshop document: threading points list

The list of threading points now only includes the thread points used in the cuts.

Wire - Selectable element filtering

When attempting to select an unsupported element, the Set wire geometry and Cutting commands are no longer
available in the context menu.

Wire technology - Cutting type addition

A new NC Type field has been added to the Wire EDM Machine tab of the machine properties. It can be accessed
from the Machine > Machine Properties command. It also appears in wire technology documents, with the default
value None.

Additionally, a cutting types list is available for each NC type. The cutting type has been added to wire document
filters and methods, as well as in a new column in the wire technology selection.

When importing a wire technology, the cutting type is assigned in the technology document. It is also included in the
technology document's name.

Wire method - Exclusion of lead in and out technologies from operation count

In the Select technologies function, the Wire cutting number field now excludes the lead in / lead out technologies
present in the wire technology document.
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Cam Operator

Required check-in for modified documents

A new Force check-in document when save option is available in the Cam Operator section of TopSolid's general
options.

This ensures that modified documents must be checked into the vault before they can be saved.

User properties in document previews

User-defined properties are now visible in the preview of machining documents.

Simulation and verification on multiple operations

You can now perform simulation or verification on multiple operations simultaneously.
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Integrated NC program editor

Read-only files

What's New in TopSolid'ShopFloor 7.19

What's New in TopSolid'ShopFloor 7.19

Discover the latest features of TopSolid'ShopFloor, TopSolid 7's manufacturing data management software!

The ISO file comparison method has been optimized. Now, ISO files that cannot be modified are automatically

marked as read-only.

| 7 e

SIS -

Q% W82

; PROGRAMMNUMMER : 2484891

P b

; ZEICHNUNGSNUMMER : 248489
;BEZEICHNUNG: Gehaeuse

Automatic space

11.09.2024 15:40:44

;PROGRAMMNUMMER : 2484891

; ZEICHNUNGSNUMMER : 248489
;BEZEICHNUNG: Gehaeuse

insertion

Ad d-only)

apted (rea
7

nes: 220 Characters: 51063

R RO RO RO R R RO RO

A new feature has been added to the NC program editor to automatically insert spaces between coordinates,
significantly improving code readability.

126
127

128 =
128 | G1G41Y193.549
136

131
132
133
134
135
136
137
138
139
148
141
142
143
144
145

;ANFAHREN END
GBX-58Y238.5497-3.394F15000

G2X77.257Y181.351=AC(22.232)1=AC(63.349)
G1X148.971Y147.909
G2X191.322Y-119.338I=AC(88)1=AC(8)
G3X191.276Y-119.381T=AC(218.641)I=AC(-148.624)
G1X92.561Y-211.756
G2X3.5090Y-246.889T=AC(3.599)I=AC(-116.689)
G1X-5@

G1G48Y-291.839

Geri1

GOY238.549

Gez-3.394

GezZ-9.04

G1Z-12.04

G1G41Y193.549

G1X22.232

Improved pre-comparison for WPD folders

®

=

It

Copy

Insert

Print
Renumber /
Insert space |

0= [iT]er

Tool filter

Highlight rapid traverse

[

Pre-comparison for WPD folders has been optimized to distinguish between relevant and irrelevant differences,
making comparisons more precise. In addition, the context menu has been enhanced with new commands
—Save changes, Rename and Delete— improving operation efficiency.

) B3 12 R B &

Q%W e o

F -
(=] DUMMY.SPF

L1000.5PF

(51 L1001.5PF
=
=

[ L1040.5PF
() L1045.5PF

‘= _14nc3 €oC

Eb Compare files
E(g Compare file with
= Save changes

[l Rename —
e e Tl Delete

;Prg-Num: 47

;PP-Lauf: 26.3.2019 16:41
;Programmierer: KopP

;Maschine: GTX GAMMA 2808 TC

[ BACKE D87 5.MPF
(=] DUMMYSPF
L1000.5PF

(=1 L1001.5PF

L1045.5PF

= 14ng3 eoC

TopSolid

;Prg-Num:
;PP-Lauf:
;Programmierer:
s;Maschine:

05.0420
a7
26.3.2019 16:
KoP
GTX GAMMA 200
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Block number differences

Differences between block numbers are no longer highlighted.

1087 L 720 FMAX

108 L X-115 Y78.3 FMAX
189 L 72 FMAX

——110 L Z0

___ 111 L ¥11@ RR

=112 L x-65

— 113 | X-60

T 114 L xe
1151 X580

117 | 2280 FMAX

118 FRUECKZIEHEN BEGIN

119 p1

120 | Y-479.2 FMAX

121 fRUECKZIEHEN_END

122 [ALL LBL 20@ ;PLANE RESET
123 - 0P4: ABLAENGEN

13

125 fANFAHREN_BEGIN

126 [ALL LBL 204 ;B188 C-99 / C :
127 | Xi1@ 7183 C-9@ FMAX

128 | Y20.8 FMAX

129 | 73 FMAX

ANFAHREN_END

=——]116 | Y78.3 Re

=
o
B

[y
am
o

[ 22 Fmax
132 | ze
—{133 | vs2.s RL
—J13a | xee
=135 | xo

136 | X-50

137 | Y20.8 R@
138 | 728 FMAX
139 | Xi1@ Y73.3 FMAX
148 | 72 FMAX

TIT L 0

142 L Yles RL
143 L Xe@

144 L X8

145 L X-5@

146 L Y73.3 R

Search and replace

-99 ; B : 180

188 L Z+20 FMAX
189 L X-285 Y+78.3 FMAX
118 L Z+2 FMAX
111 L Z+0
112 L Y+11@ RR
113 L X-235
114 L X-23@
115 L X-17e
X-12@
Y+78.3 Re

Z+20@ FMAX
; RUECKZIEHEN_BEGIN
1

Y-479.2 FMAX

; RUECKZTEHEN_END

ALL LBL 280 ;PLANE RESET

0OP4: ABLAENGEN

3

; ANFAHREN_BEGIN

ALL LBL 204 ;B180 C-%@ / C : -99 ; B : 18@

X+88 7+1893 C-9@ FMAX

Y+20.8 FMAX

Z+3 FMAX

; ANFAHREN_END

Z+2 FMAX

Z+8

Y+52.5 RL

X+30

X-38

X-3@

¥+20.8 RO

Z+28 FMAX

X+80 Y+73.3 FMAX

Z+2 FMAX

7+

L ¥+105 RL

144 L X+38

145 L X-30
L
L

143

146 X-80
147

The NC program editor now offers enhanced search and replace functionality. Press the F3 or Shift+F3 to initiate
searches, with results highlighted and numbered. Advanced options such as case sensitivity, whole-word search
and regular expressions are now available. You can also switch between Search and Search and replace. Finally,
the search mask is now movable and integrated directly into the editor window for a smoother experience.

f) NC-PROGRAM EDITOR

426060
ORI SIE-5] Search and replace

1001167 -
=R B »
109 *

1110 %|Aal] Ab o~
LT
1312 * -

1413 * - T98 MSSTASTER

1514 TOOL CALL 98 Z S20

16 15 TOOL DEF @

17 16 ;

18 17 * - EVENTUELLE C-VERDREHUNG IM NP39 ZURUECKSETZEN:
19 18 CYCL DEF 391 PRESET Tabelle ~

20 0305=+39  ;NR. IN TABELLE ~

21 0381=+99999.9999 ;X-PRESET ~

22 0382=+99999.9999 ;Y-PRESET ~

23 0383=+99999.9999 ;7-PRESET ~

24 0384=40 ;A-PRESET ~

25 0385=40 ;C-PRESET =~

26 Q386=+0 ;machine datum ~
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Keyboard shortcuts

New shortcuts improve navigation in the NC editor:

» Ctrl+N: Go to the next difference.
* Ctrl+B: Go to the previous difference.
* Ctrl+0O: Apply the difference to both sides.

What's New in TopSolid'ShopFloor 7.19

The existing shortcuts Ctrl+L and Ctrl+R remain for left and right actions, respectively.

# IS0 FILE COMPARISON

B =] o Q%W E s

23 *T2213 ;VHM-BO-10,2-3XD
Y

Adapted
0212204102517 | KB13 | Line504 | Characters: 12857
*T2213 -BOHRER DM10,2

£o FrovESY A1a v A4 AT
Loading time: 0.084 | = 100 differences  # 14 irrelevant differences

25 *VERWENDETE NULLPUNKTE 26 *VERWENDETE NULLPUMKTE
26 CYCL 91 PRESET Tabelle ~ 27 CYCL DEF 391 PRESET Tabelle ~
NR. IN TABELLE ~ Q385=+60 ;NR. IN TABELLE ~
-PRESET ~ Q38 ;X-PRESET ~
-PRESET ~ Q38 ;Y-PRESET ~
39 ;7-PRESET ~ Q38 ;Z-PRESET ~
A-PRESET ~ Q3 ;A-PRESET ~
;C-PRESET ~ (Q385=+180 ;C-PRESET ~
MASCHINENNULLPUNKT ~ Q386=+8 ;machine datum ~
Q387=0 ;PRESET AKTIVIEREN Q387=+8 ;PRESET aktivieren
S ERRRE TR B R R AT AR RS
BLK FORM @.1 7 X-533.5 Y-7@ 7@ 29 BLK FORM 8.1 7 X-533.5 Y-7@ 740
BLK FORM @.2 X533.5 Y@ 7118 30 BLK FORM 8.2 X+533.5 Y+0 7+110
SRR R FL R S
M17 32 M17
M7e 33 M78
SRR 34RO R R
* - T1111 ;ECK-FR-DM63 35 * - T1111 ;ECK-FR-DM63
SRR 36 3 HERHEE R R R
TOOL CALL 1111 7 S150@ Fl4e@ 37 TOOL CALL 1111 7 S15e@ Fl4ee
L X11.69 Y-0.5 71180.5 FMAX M91 38 L X+11.69 Y-0.5 7+11@0.5 FMAX M9I1
CALL LBL 200 ;PLANE RESET 39 CALL LBL 20@ ;PLANE RESET
FN@: Q93 = +136 ;LAENGE 40 FN @8: Q93 =+136 ;LAENGE
FN@: Q92 = +31.5 ;RADIUS 41 FN @8: Q92 =+31.5 ;RADIUS
FN@: Q91 = +0.5 ;LAENGENTOL 42 FN @: Q91 =+0.5 ;LAENGENTOL
FN@: Q98 = +8.2 ;RADIUSTOL 43 FN @: Q90 =+8.2 ;RADIUSTOL
CALL PGM TOOL_CHECK 44 CALL PGM TOOL_CHECK
TOOL DEF 1267 45 TOOL DEF 1197
M3 46 M3
* - OP1: PLANFRAESEN 47 * - 0P1: PLANFRAESEN
CYCL DEF 247 BEZUGSPUNKT SETZEN ~ 48 CYCL DEF 247 BEZUGSPUNKT SETZEN ~
Q339=60 ;BEZUGSPUNKT-NUMMER Q339=+60 ; BEZUGSPUNKT - NUMMER
48 ;ANFAHREN_BEGIN 49 ;ANFAHREN_BEGIN
49 L 71098.5 Be Co FMAX Mo1| 50 L Z7+1100.5 B+@ C+@ FMAX M9l
50 L Ce Re FMAX 51 L C+90 R@ FMAX
51 CALL LBL 201 ;B8 C@ / C : @ ; B : @ 52 CALL LBL 201 ;B0 CO / C : @ ; B : @
52 M25 M26 53 M25 M2&
53 L X-583.391 Y1.5 FMAX 54 L X-583.391 Y#1.5 FMAX
54 L 1205 FMAX 55 L Z+205 FMAX
55 L 7@ FMAX 56 L 7+ FMAX
56 ;ANFAHREN_END 57 ;ANFAHREN_END
57 L X583.419 F AUTO 58 L X+583.419 F AUTO

e v.Ee3 M1a v a4 ar

Macro

When you click on the preview image of a macro in the NC editor, it is enlarged and displayed next to it. A second

click reduces the preview.

—

MACRO

G71 - Roughing cycle

G71 - Roughing cycle
Cutting depth

Lifting motion

Block number Begin

Block number End

Feed rate

G71U0.04 RS
1| | G71 P10 Q20 U0.04 WO F5000
N10

TopSolid

G71 Roughing Cycle

G711 U1.0 R1.0;

Gy 1 P100 Q200U0.2

- ROUGHING CYCLE
- REPTH OF CUT
- RETRACT VALUE

- FIRST LINE OF SUBROUTINE
- LASTLINE OF SUBROUTINE

)= AMOUNT LEET ON FOR FINISHING IN X
= AMOUNT LEFT ON FOR FINISHING IN Z

- FEED RATE
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Program Manager

Tool/Workholding list

It is now possible to search directly in the tool list and workholding list database in Manual mode, simplifying
specific entry searches and optimizing workflows.

TopSolid'ShopFloor taols in the 150 file

TOOL LIST Manul
nfrow OF DED %Y
i R DBD %9
3y OF B0 % T
wfow  OF D0 B Y G
Afom  OR DED %Y
nges R DED %Y
T G To2no O 90 % %
At R DED % T
1 F Ti00436 OF D80 % % &
T T TI02459 ORF 920 % %

=
v X

oosme | B

| 1 G Ti00062 OF 280
1 T TI00063 OkF 2950
1 T Tio0064 OF 280

TopSolicShopFloor List of workholdings

WORKHOLDING LIST

Database
&1 [® 10-1-250k-wo3415
&1 ™ 10-2+3-250-wo3415
1 [® 1-250k-Wo3a16
1 ™ 13-250K-wo3439
1 [ 12-250k-W03417
1 [® 1-250k-wo3426
1 [® 127-250k-W03440
1 [® 1-250k-wo3414
1 [® 1a-2500-wo3412
1 ™ 152250k wo3434
1 [® 15-250-wo3413

1 [® 154250k wo3432

Viewer package

A check-in process is now performed before a visualization package is created, ensuring that all changes are

correctly applied.
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@ Index A
@ & w 01-CAD
&/ 02-SETUP
o & 03- CAM
- & o Doku

- [ 11339789

938 ORIGINAL NATA

J )
ml PROJECT MANAGER .f/
Sort N
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PROGRAM MANAGER ./
, N
|Nré 1339789 big
Edit / Information - 7
|
= A\
Release [ Lock i
# & 600190 4
G 7) 11339789 / 600195 (!
@) Rhy Mech AG h
= (3 20147060E302400.8 /
¥ TOOL MANAGER T) WEICHENSCHIENE R=1500 WG ([
N
T e /
STORAGE MANAGER \
B
B y
It’
: TOOL SET = \
g &3 280233
00280231.cam
" STOCK MANAGER CD‘ o] Garaventa AG
= 4 80034279NS08501.8
7) ZAHNKRANZSEGMENT 90°BEARE
WORKHOLDING MANAGER - - -
g = Fed
MEASURING MANAGER |'N@ 20917057_OP1 B
45 280232
00280230.cam /
) Garaventa AG

# 80034279N508501.8
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ISO file read-back notifications

You can now define, for each machine, a list of users to be notified whe

Notifications are generated just before the daily cache reread.

TopSolid

n I1SO files have been read back.

What's New in TopSolid'ShopFloor 7.19

Multichannel Interface Rewrite
Sett. 1 Sett. 2 Sett.
g . ol
Users for notification -
USER
CHATS HISTORY
2 current
() T Alzmetall_GSI000#5-FOT
Read back fi hine | 11092024 15:41
[ capam . i Oea ack from machine | 541 |
[ Christian Nyfeler @i Read back from machine | 11092024 15:41 |
[ Gast @ 2011
) Read back from machine | 11092024 15:41 |
|:| hap . offline 2034
[] Held . offline
[] Jonathan Lehmann . offline
[] Julia FR @ e

[[] Michael Ziircher
[[] ehilipp Inderbitzin
[] Super Mario

[] sven Doswald

[] Sven Doswald laden

[ ISR

Chats

. offline
. offline
. offline
. offline
. offline
-

- DMG-DMC_100U
Sven Doswald
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TopSolid'Cam <> TopSolid'ShopFloor Program Manager interface

A new interface has been established between TopSolid'Cam and the TopSolid'ShopFloor Program Manager.

When enabled, an icon generates ISO code directly for ShopFloor. During generation, the next available program

number is automatically assigned, and in ShopFloor, the ISO file is linked to the corresponding CAM file.

88

Y] Options

B [5 CAM Opticns -
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B Attributes

ShopFloor Endpoint
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What's New in TopSolid'ShopFloor 7.19
Tool Manager

Clipboard

A new option lets you display and modify the active machine in the clipboard. This feature makes it easy to quickly
switch from one machine to another, ensuring that the correct machine is selected.

%/ CLIPBOARD = - O X

| coooo1s

Total length
165mm

A

Y

Temporary manual changes

If a tool must be manually replaced temporarily (e.g., due to stock shortages), an option can be enabled when
loading the ISO file onto the machine. This option deactivates automatically once the tool has been removed from
the magazine, ensuring smooth replacement and optimized management.

[V@ MACHINE & ?TOOLS 3

[] sort by exclusive tooi
e TopSolid'ShopFloor tools to add
) —————

%2 PROVIDED 5

424513E-0P2

o

(2
@ 50050H-0P1
£ - TOOL LIST o @\
&9 4245132 -
* &) 00499562.cam ’ I} 0‘
o - w2 s -
@ azas14C = ) @‘
(D) GEHAEUSE R043 DN35x336 g soosokrd || % oz )
5 - () GEHAEUSE 7 ‘
g @ = ’7‘?'?100436 9‘ Ok @
. q
D»re 203300F-0P1 ) ‘ T s 9‘ o @‘
@ 745700-OP1-VA| ‘ T Tio03s2 Q‘ = 1
69 2033001 = ‘ T Tio0620 a‘ sed” (1) im)
@) 00297915 7
o & cam < & 00t ‘ T mooe Q‘ O l@‘
3 203300F N ‘ ‘
[6] 'GEHAEUSEDECKEL R650 DI @ EI 745701 ? Tioosts a
§ . o ‘ TIo0698 ‘
s | ) @ ﬁ gy 0= TESTSTUE 7 @
. 2 ‘ T Tioos3s a‘
@ 2484891-0P2 O ‘ F T340 0‘ #@_
=m0 ‘ 7 mome 0‘
1 2484892 g [ @‘

& 00510542.cam 7 Tool is changed manually
& 7
© S sum § EEN
(7) GEHAEUSE R021 DNS0X336 v | EEE————
Ok
g o 8 T es §- 1 T
In *provided” (36) im
‘%nomso = Q‘
‘ﬁ'noneo I} @‘
‘ F nonzz = (] ‘
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What's New in TopSolid'ShopFloor 7.19

Subcomponents

Subcomponents can now be defined for tool components, such as a screw for an insert. When the main component
is used in a tool, the corresponding subcomponents are automatically added.

90

[l componeNTs.s

» 7 9/ fo

[1 COBSSE - 211860 VEGT220530-FN HB
B Garam

* e e I
ok = i)
| ] BemWpls2ad3

= ;
1 T i to

2
=2
i

| [ Bemiplesian
1 il L= I
S o
| 1 cosaons
. ;
= [ to
| [ comoo27
1 A o 8 T
0 W o
[l cooon2g
B Sancii
1 A o 8 T
0O Wi o
1 cooeass
b sandiic
o R
[N ] o

| [ CODO44 - CCMT DEO20BEN-AM
B o

"% TOOLSe:n

Ti0084
ﬁ TI0084 -

2 O BF
|%1mmns

¥ End mill D822

A O 0%
4. Tioessa

¥ NCsporting drill D12 x 90 degree

A O9 D8 WO

233
¥ Radius mill D20R1 23
b 74 B BE
% 3328 TH000
¥ 3328 T1000 - Radius mill DI6R1Z4 -

o e )

3328 T002
¥ Radius mill D8 R1 23 rough

o Of 98 F([

3]

.
| % Radius mill D20 R1 Z3
v O D8 HQ
|% TVI0004

¥ TWI0004 - Rsdius mill D16 R1 Z4 - Rar
o Of 99

TVI000S
T TWI000S - Radws mill D16 R1 Z4 - R

-

@ %% FILTER

F— 9

Function

N

5 Insertmum “
Size Radius
- -
Cutt. edge shape
~
Holder type Holder size
- -
Cutting material [ incl. con. suitab.
(7)) . B -
Mame Folder
~ v

Description

(D) InFo

Parameter
Name: COODSE3
Fart numbes: CO00069
Description: CNMG120408 MS TM4000
Comment: Insert
Manufacturer:
Manufacturer P:
Additional PN: 610238
Falder: € - 03 - Turning Inserts (Wendeplatten Dre
Library: vatTOOL COMPONENTS
Storage lncation: QUIRD 4 3 1
Supplier:
Order number:
Stock: 23

i

Function

Insert turn

Size 12 .
Radus 0.8 -]
Cutt. edge shapes €

Cutting materiak Ceated carbice

Insert
Halder type: © n
Haldes size: 12

[ | () INFO

Comment
“
Additional PN
-
Supplier O
( -
N’ Starage location Regrindable
- -
Libeary State
- -
o e 0
=
? FILTER
Function
LI | . |I: l !.I
w
Name Falder
v v
Part number Description
v -
Comment Manufacturer
v -
Manufacturer PN Addrional PN
v w
Library Holder
v v
State Tool properties
v w

Cutting material

Tool length

[ Incl. can. suitab.

Util length

Parameter

Name: T10064
Part numbser: T10084
Description: T10084 -
Comment

Manufacturer
Manufacturer P:
Aditional PN: AAT2COCE
Toal length: 178165

Uil bengthe 0

Holder HSK-AB3

Folder: vatTOOL HSK-A100
Library: vaTOOL HSK-A100

Functions

External turning [ |
Size 12

Radius: 08 Lo

Cutt adge shape: €

Hand of taal: L

Cutting materiak None

H SUBCOMPONENTS

Filter ] Shows all
-
>

Companents

(B woos & %4
|, Tt ISR ]
I, enyTestd001 ISR ]
I [l eoceanz =] I
l, E000003 SR ]
I_ E000004 B %
I: E000005 B %
I_ EQ00006 B %
|_ E000007 B %

& E)

Added componeats

1 e 28 CJ[

Component groups [ Group favorite

J EXT. COMPONENTS
Filter ] Show ail

Companents
[[1 oo © 0+

1 mm B % e

L =)

Companents in tool

I [l 1xcooteos

I [l 1xcovossa

l: 1%E000002

Companent groups [ Group favarite

-
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Material usage inheritance

Automatic inheritance of material usage from components to tools is now possible. A client restart is required for
the new definition to take effect and for the changes to be visible in the tool.

[l coMPONENTS s e % AR 147 PARAMETER Ts'sF (i) INFo

e I I/@\ Function Marusfacturer (TS'SF) Parameter
A T N RO Mame: COD1017
l'—_‘ CONONS @36, @487 60" o Part number. CO01017
Sanchik | ‘ﬂb ~ e e T ) Description: End mill 08 22
1 .
Comment
A o e
= i of o fo Mardacturer:
Mame Folder Aftermative / previous part.-no. manufacturer
Manufacturer PH:
E coigs = v - Addiianal Ph: 611412
Guehring | (@ — —— o Falder 8 - 06 - Slot mill (Schaftfraser m. Zentrums,
r Library: vaTOOL COMPONENTS
+1 7 e
[ S ] fo - - Storage Iocation
e Comment Manufacturer Supglier
l_—: o Order numar
Sanchik /— v - Supplier Stack: 0
-1 0 %% e l\® Manufacturer PR Additianal PN T .

Function

a9
I l; o (?0) EAN Supplier O C Slot mill "
=« 98 || v ] Ll A i
©

Mismber of teeth: 2

— Storage location Regrindable o Custting material: Coated carhice
L comon? ( ny » » 15 wear part
[ b5 spare part
-1 E 0 5 \@ p— srate [ Mot masaget in comptane toal Tooling shank ! '
L= / . » O e Marcrdy ::::::.az,'hndnﬂe
I COMINT - 490R-1404200-PH 4230 K_\ Suitable ‘Conditionally suitabile
Sandvik —n =]
o | ( DL al [ B .
“+1 [ i fo = Cw v [m - |
| E cooions @ - - i
1 0 weE fo v v
I E COUI0NE 220 auf B6 - -
Wehlhaupter | [ D
-+ 0 %\ b
I E COT018 - HCR1435 =
WNT al
729 ) |
T TO0LSw L\f_,?) 217 PARA. TS'SF GLOBAL (7) INFO | exr. components
N o N .
( Tool fife limit (min.) Toal fife warning Emit Parsmcter Filter [ Show all
TI0008 \ . .
End mill D& Z2 }—_\% 1000 &0 Name: TI00108 3
. . Part number: T100108
£ O op o) (e Caen e e

ottt
N ) Description: End mill 08 22 Companents
| e o Comment T

TiD0£80 Manufactirer I I eoooezs
End mill D10 23 finish ni=ik O Manufacturer P
— L Additional PM: | u i

E 5] A4 98 HME [/fié) Xvalue [l notmeszae  Tolerance X min_ f max. Taa length: 170

@B =
2
2

4 1 o Util lengeh: 0 | et )
% ULLTD . Hokder. HSK-A100 I e S
Edlepe 22 Yvelue [ notmasus  Volerance ¥ min./ max. Folder: 06 - Skt mill (Schaftfraser m Zentrumsschn P
= - o Library: vaiTOOL HSK-A100 I eooocn B 80
+ O4 B8 8O || =
{ Zvalse [ notmezmse  Tolerance Z min. f max. | [ eooo00z 02 %
| & Ti00670 . . B A !
End mill 06 23 finish gy, N Functicns o
1l @ Rvalue [ notmesnwe  Tolerance R min. / max. = ! o B W n
B Of 98 5O [N Slot mill |
a Diameter: 8 | [ eoouo0s B %
Length: 17.1 L
TI007TE [l P Pumber of tasthe 2 =
End mill D20 Z4 finish INOX — . Cutting matesiak: Beschichtetes Hartmetall | [l eooocos o %
2 o | 2y - |
o 14 0B M@ L‘\d-ﬁ Cverride Adspterid =t ZOLLER = |ﬂ E000006 IR e
Werkzeugparameter Siemens = 120 |
Tioo&22 ing =
String = Test =
End mill 0222 oteger = 5 ST (=

Conditionally suitable

w08 98 B0 ==
-

% TI00946 L1
End mill 06 73 rough

B O 98 B0

Companents in tool
I [ 1xcoomas 2% =
[ oncor %9 =] [+]

€€ <€ ¢ <

€[ < | [e |
K

TIO1049
End mill D2 22 Tool properties

o G 98 @O _ “HE

Tio82
End mill 025 24 finish | L
| Companent grou [ Group favarite
A o panent groups P
© O4 98 B@ =l
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What's New in TopSolid'ShopFloor 7.19

Tools to add/remove - PDF

Tools to be removed are now listed in the tool list. You can also generate a PDF list containing these tools.

£% MAGAZINE ) EE

Search tool ( Send import file of the meagdfed tools
o
o L&

£%1 T Toosa0 )
% T100540_1 / - '\

*1@1 ‘\j ¥ o e
ez 00778 F Tos0s i <}
007781

FO ¥ 02423 O
£¥: 7 Tioosso ¥ r0s201 <]
1004501

¥ X

F mios04s 0o

& 101

Lra  §F mo2a ] 0e
Fomoans s + 0280 7 6
o ‘% TO REMOVE i
¥ F © -
%

Y Remove all from magazine

£¥6 T T034s £% o T 1099 7%
&, To1346.1 = .
&1 £F w2 P Tiowsor A% Q
%7 ¢ £ 8¢ F Tios0ms e ]
_é_ Lo T rone EEe <]
i ¢ ¥ 200 F ioeee 1% Q
¥

+
‘i?? 7

=

Tool state in setup/dismantle list

The state of tools to be set up is now transferred to the setup/dismantle list.

Set up (2) Dismantle (1)

£¥s ¥ ro2e £¥2  F moorrs

$%7 1‘ T104291

Tool length: 238
X9 Y- 7239.758 R-

Additional PN:
Tool length: 205
X0976 Y- 7204093 R-

Name: T102423 Funct
T102423 Diam

Schaftfr. D20 Z4 schl. INOX Lengt

Radiu

Angle

Mumk

Cuttin

mzm Funct
Part number: T104291 Diam:
Description: Spiralb. D18 4xD Lengt
Comment: Radiu
Manufacturer: Angle
Manufacturer PN: MNumk
Additional PN: Cuttin

Create & finalize setup / dismantle list

92
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Util length

The new Util length parameter is automatically retrieved from TopSolid, but can be adjusted manually if required.

Tool length
170
Util length
40
407
Function
35 r
171 [ Diameter,"Width Length/Depth
] ; ) )
[ =
|
d Radius/Pitch Angle/Shape
1
Mumber of teeth Cutting material

Non-dismantling tool

Tools can now be marked as "Tool is not disassembled". If dismantling is attempted, a warning message appears,
but the tool can still be disassembled.

'H% PARA. TS'SF MACHINE

Tool is always in magazine
Tool is changed manually

Tool is not assembled/measured

] BEERLY

9 Attention!

Tool is not disassembled

Magazine pockets required 1 The tool should not be disassembled as standard. Should it be disassembled anyway?

4

Tool parameters

sefzew = LAMG
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What's New in TopSolid'ShopFloor 7.19

Component state inheritance

Component state is now transferred to the complete tool. For example, if a complete tool contains a locked
component, it is visually indicated as locked even if its actual state remains unchanged. When a program is released
or provided, it is automatically checked for locked components. If detected, a warning message is displayed.

TOOL LIST Manca TIoM22
I-m T TI0N22 T 08 2 % & %ASSEMBLED TOOLS % H COMPONENTS
PO P 62 m ?&3 o o Tom22pa [ 1x cooonz7 b %%
. i . 2 () DMU_100NEU  [“H DMU_100_NEU
_ 5 o Oy O c §
1 T TI09699 A=l R Mixcoonsza [ 7809 :)gil
- 2 @ omG-DMC_1000 £ DMG-DMC_100t 6 C000338 L 78 o

1 T Ti02337
-1 T Ti02830 )
- T T100436 )

- T Ti02340 -

- T T104994 )

-1 T Tio0822 )

&

&

= :
- T Tio2182 Ok 80 %% %

=

=

Standard storage place

When an assembled tool is linked to a standard storage place, a notification now appears in the following cases:
when it is loaded from the magazine, if the standard place corresponds to the machine's standard storage, and
when it is disassembled.

TepSclid'ShopFloor Edit assembled teol
@’ T10010825

Name Offset ¥

T10010825 ]
Current machine

DMG-DMC_100U ~
Remaining tool life ITN number Actual value X Actual value Y -

1000 25 4 0 -

L Information

Location Stand. storage place Actual value Z Actual value radius o

Tool assembly 7 170 0

This toel (T100108|25) belongs in the standard storage pocket L1_17

Current IS0 file

Process.

Assembled: 18.10.2024 10:14:51 / Preset: 01.01.0001 00:00:00
On machine: 01.01.0001 00:00:00 / From machine: 01.01.0001 00:00:00
In storage 01.01.0001 00:00:00 / From Storage: 01.01.0001 00:00:00 Ok

IN_STORAGE GUID

~ | 97dd61b8-ee35-4282-98d5-c0f3 1e688c4b

1S_BARCODE |:| IS_REGRINDABLE STATUS
1S_MEASURED IS_NEW_CUTTER Assembled ~

1S_NEW_MEASURED
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What's New in TopSolid'ShopFloor 7.19

Regrinding tool management

Components requiring regrinding are now managed.

|;| COMPONENTS 12125

<
ﬁ% FILTER (1) InFo @REGRlNDlNG

P Function :
-~ = Parameter Regrindable
BT EE R Rame: cootar?
[ connes oart mumben 301017 Maximum regrinding length in Z
- Description: Eng miil DS 22 ‘ 5
Comment:
2 en @
‘ » 0 9% [L Manufacturer: Maximum regrinding length in X
Name Folder
Manufacturer PN: ‘ 0s
I C00896 - 211860 VCGT220530-FN HB ~ v Additional PN;: 611412 :
Garant ; .
20 || part number e Folder: 3 -06 - ot il Schaffeser m. Zentrums
‘ * g &e b Uibrary: vatTOOL COMPONENTS o
~ ~ Storage location:
J— o Comment Manufacturer Supplier:
[l Order number:
~ ~ Stock: 0
» > f [ ? Manufacturer PN Additional PN * il
. . Function Tt 22 T ()
33tz
Garant EAN Supplier O Slot mill ' ‘
Diameter: 8
Storage location (1)
‘* g %% b 2 & Length: 17.1 7
§ . Number of teeth: 2 e T
a0 bacation] (=t Cutting material: Coated carbice T >
H E000238
dnd “
- Library State Tooling shank H ‘5
‘ + pal e s Holder type: Zylindrisch 8
e ¥ Holder size: & For regrinding At regrinding
H MC000012 ‘U ‘u
aQ K 41 KX

o5 &
‘ ) o @ El [L’ Add storage location

H +0.1 - M10 6H/39/C00797 E Component storage
Fraisa . E‘ Eﬁ
|+ g o8 b

I H +0.05 - M3/17/C01667 e e

Tray Compartment

Add new storage location

= 2 %e b

I [ w0as-mesorcotses —
m
‘f‘é ASSEMBLED TOOLS @
T100108
Assigned assembled tools (%3
TOOL LIST :- T, Ti00108.3 @ om0 TEST 4.1
I-B:U % 100900 - % % @ gg 0&' ):,Zw| I|fi‘,momum @ma-nmmzsuwl
T, T100108.1 (@ Tool assembiy
[+1 § oamo OF D20 % § &
|4 % monss OB DBO BT & —
Disassemble tool Ei:
41 T 1:B 7 el % % Lé| .
100108 1
If T TI00108 7 DY) % °i {%| Caent machine
DMG-DMC_100U ~
/ Remaining toal lifie ITN numi
1000 3 Q.
Location Stand. grage place
Tool assemily .

£ oroers EDIT G
5 || Order number e
= @

- G
@] Sandvik Coromant
s | |
Positions
% [ cootorr
L] waiter Order quantity 2
@ Partial aelivery:
O @
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What's New in TopSolid'ShopFloor 7.19

New filter for assembled tools

A new From machine filter is available for assembled tools, allowing specific selection of tools returning from the

machine.

@ MACHINE

DMG-DMC_100U

% TOOLS m

0, T109851

T109351 - Radiusfr. D3 RO.2

= )

L, TI05653
End mill D5.5 72

0 7

0, TW02296
End mill D6 Z3 fit

o @

Extension of the removal list during assembly process

= TOLERANCE -
¥ ™
\j X value: 4 Tol minc 01 Max; 0.1 ﬁ FILTER
¥ value: 0 Tol minc Ba: -
Name TEST Drz
Z value: 1M Tol minc 0 Max 3
1 C v [ v [
et R value: 0 Tol minc Ba: . :
o
% ASSEMBLED TOOLS [+ NG| FILTER FOR ASSEMBLED TOOLS || )
R
T A
= I || T0ows None ~ M H |
Assigned assembled tools '\\h _f,"
None —
T, TI00108_3 (@ ToTo_TEST 41 it I e mEs e { % y
Provided b A
~
| o, Machi -
= | T7, TI00108._4 (©) oms-pmc 12501 | aeine y o3
To load | IE |
- I‘\.___,’Jl
T, TI00106._1 (@) Tool assembly | [From machine |
| I
Assemble tool EE
Disassemble tool E‘ﬁ

You can now define certain complete tool components that, while not requiring assembly or measurement, still
need to be removed from storage. These components are automatically added to the removal list during the

assembly process.

96

‘Hé, PARA. TS'SF MACHINE

Tool is always in magazine

Tool is changed manually

Tool is not assembled/measured

| Post components from storage

Tool is not disassembled

Magazine pockets required

LRI O K]

<

Components to be posted

1xC000134

1xCO0M017

O

TopSolid



Tool Set

Preset templates

What's New in TopSolid'ShopFloor 7.19

Specific templates for tool presetting can now be defined and selected directly in the Tool Set, enhancing efficiency

and user experience.

TopSolid

Sett. 1 Sett. 2

Part numbering

SMB authentications for the dlient (at startup)

Tool components

Format ~C"00000
Start number 10000
Regular expression format Qd+

\Apply parameters for the same component

Regular expression for specific paramet C\d+

Reqular expression for all parameters | NOT--DEF

SMB authentications for the server {at startup)

Path for TopSolid"WebExplorer

Tool
[] Format and start number per library

[Format “TEST"#
Start number 1000

2D drawing template

Global numbering

Description in comment

Description for turning tools from 2nd component
Create offset point

Random text in additional part number

Create 2D drawing automatically

Manufacturer’s part number in manufacturer's part number
Always correct the view when adopt the tools

Display in the comment field of the tools
Description ~
Display in the comment field of the tool components
Manufacturer ~
Regular expression for permitted tool UID

GUIDWd+

Reasons for requesting tools

Kaputt
Will neues

Templates for presetting

SPIRALDRILL
SIDEMILL

Article
Format “E'000000
Start number 1
Regular expression format Bud+
Assembled toal B[]
Machine (165) Requested 7= qlg. @

‘ ¥ 1io03ze [56) ‘ ‘ ¥ 103aer

‘ F Ti00as0 [} ‘ ‘ F ro70ss

‘ t roosa = ‘

If"oﬁmmu @LAQEIDMC_D_] l 2.250 47

Offset

[# rinzes 2 |

150 file (0) To load (7)
‘ ¢ Toor7s = ‘
‘ ¢ T00000 O ‘
‘ ¢ mozn 0 ‘
[ & imsno =

Measured (240) Not measured (6) Gl il

‘ ¥ nomsoe I @‘ ‘ T rosasr

‘ § nones = 8‘ ‘ ¥ w7045

¥ ronea 7 @I ‘ T 00900

‘ § monzzs > 8‘ ‘ ¢ mozn

‘ § nozar = 8‘ ‘ ¢ Tosos

‘ § mones > 8‘ ‘ ¢ Tiososs

‘ ¥ moue o @‘
‘ § moen = @‘

= = el

Actual value X Actual value ¥ Actual value Z  Actual value rac
Save offsets Remaining tool life
[} / 500
@I PRESETTING DEVICE
ToolSetKelch ~  Interface: KELCH
Mess. program No. of cutting sdges
~ |4
Tolerance Zmin  Tolerance Z max
0 E]
Tolerance X min Tolerance X max.
0 0012
a 4 SIDEMILL O}
\ ﬁ Revolver pocket: -
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Storage Manager

Assignment removal

It is now possible to remove the assignment of an intermediate reserved storage space, offering greater flexibility in
the management of storage resources.

: P
% ASSEMBLED TOOLS ‘-\@ STORAGE  (Occupied: 3, Fre=:3)
T1000 T1000 - T1000 - REIN-FLUEGEL

17.04.2024 11:48:43

T1000 1  RW3 assigned to: DMc200U@1 < X]

Assigned assembled tools m Ei

e

'f‘r‘ T1000_1 RW3_R1.6_1

Taken from

Display of tool removal date and time

The Storage Manager now displays the date and time the tool was removed from storage, improving traceability.

2

E@" TOOLS =0 - ‘% ASSEMBLED TOOLS “\%;

T100540 ==

‘ ??1010: - ‘ 11.09.2024 09:10:49 =
* 7 %Y WA Assigned assembied tools [ Ei

I . T100540)29 NASS5_16_Riickgab l

% T100540
NC spotting drill D12 x 90 degree

» O 98 HQ

,i, 12313
Radius mill D20 R1Z3

" @ - N
) O 08 M@ &

3328 T1000
3328_T1000 - Radius mill D16 R1 74 -

E o H WA

‘ 3328 T1002 ‘

Radius mill D8 R1Z3 rough
- .
B O 8 HE
‘J‘;_r' m Taken from
<)
Radius mill D20 R1 23 Julia (11.09.2024 09:09:52) °ET
A en e
= O 98 =@ &
v
ﬁ' Tvio004
TV10004 - Radius mill D16 R1 74 - Ra Storage
. 1010 v 15
2 e @ ;
+ O 98 K@
Pocket
Tvi0005 » L
TV10005 - Radius mill D16 R1 24 - Rau
. g T
o o3 - 5 =
- 7 98 @ = =
V0006 Automatic load / unload L
TV10006 - Radius mill D16 R1 24 - Rax
- o .
+ O e =E
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What's New in TopSolid'ShopFloor 7.19

Simplified representation

A simplified representation is now available for large storages with numerous pockets, optimizing loading times and
improving efficiency.

50| STORAGE

Choose storage
TOTO v

Create storage

For complete tools
|:| For workholdings
Simplified representation

Save storage
Delete storage

Create barcode PDF

Create .csv file on desktop

TopSolid 99



What's New in TopSolid'ShopFloor 7.19

Standard storage place

When an assembled tool with a stored standard storage place is selected, the standard storage place is displayed
as text. If you attempt to load this tool into a pocket stored as a standard storage place for another tool, a warning
message appears and the action is canceled.

£
ﬁ]‘t‘ TOOLS =0 & % ASSEMBLED TOOLS ‘:-\%%)-‘ STORAGE  (oceusiedt: 140, Free: 260)
=
g3 ron e (=)
T tnamiios 22 = T100540[29
* [} ‘_’fj\ L= el (1) Assigned assembled tools L& HZ Stand. storage place: TOTO_TEST_7_4
- oveen I T TI00540j23 (9 Mas5_16_Riickgab I
¥ NC spotting drill D12 x 90 degree
# 0 HF B0
£ 12313
¥ Radius mill D20 R1Z3
s 008 B el

4, 3328_T1000
¥ 3326_T1000 - Ragius mill D16 R1 24 -

=} 0O 8 00

0, 3328_T1002
® Radius mill D& R1 Z3 rough

o O %Y RO
a m Taken from
J L El IR Julia (11.09.2024 09:09:52) i
- g %% &[0 Storage
~ K
4, Tviooos
E TV10004 - Radius mill D16 R1 Z4 - Ra Storage
S ~ ToTO o
- g %% &G
Pocket
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Filter

Improvements

The filter for complete tools and tool components has been completely redesigned for smoother, more dynamic
user experience. Performance has been significantly improved, boosting process efficiency. Mapping has also

What's New in TopSolid'ShopFloor 7.19

been integrated, enabling the compatible components to be filtered (e.g., a drill with a cylindrical tool shank can be
paired with a cylindrical, Weldon or shrink-fit tool holder). Finally, you can now filter by functional groups or select

tools and components with no assigned function.

TopSolid

o
359 FILTER

Function

| | | | i 1
Q|’|_| Drilling tools

| Twist drill

Diameter

Angle

MName

Part number
Comment
Manufacturer PN
Library

State

Cutting material

Tool length

1%

Length

Number of teeth

Folder

Description

Manufacturer

Additional PN

Holder

Tool properties

[] Incl. con. suitab.

e L

Liil length

~a
IO el

=7
ﬁf’ FILTER

Standard ~ \E
*** Tooling shank Cylindrical == 0:
Holder : £
Size: 10
Function
N I RO B
i3 Tooling shank r
Holder type Holder size
- -
Tool holder type Tool holder size
- -
Name Folder
- -
Part number Description
w w
Comment Manufacturer
- -
Manufacturer PN Additional PN
- -
EAN Supplier ]
-
Storage location Regrindable
-
Library State
w w
o & S =
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What's New in TopSolid'ShopFloor 7.19

Settings

Decimal separator

The decimal separator is now configured independently of Windows settings in ShopFloor, simplifying operations.

Sett. 4 Miscellaneous Dashboard

Maximum number of 150 file revisions

Maximum age of 150 file revisions (days)

Eo

90

Select tool parameter

Tool parameter “Description”

Save parameter

Several languages in Top5Solid (DE:EN:FR#DE)

DEEM:RO£DE

Display name for tools

Mame

Create barcode at the components with

Additional PN

Choose global TS'SF language Decimal separator

de-DE -

Tool properties

SCHLICHTEN
VORSCHLICHTEN
SCHRUPPEM
MEUWERKZEUG

102

Create tool parameter

Tool parameter “Default value™  Tool parameter "Type”

Delete parameter

Select tool state Create tool state

Display name of the tool state

State color Connected TS'SF state

|:| For complete tools I:‘ For measuring equipmnets
|:| For togl companents

D For workholdings

I:‘ For Measuring equipments instaces

Save state Delete state

Visibility of proje

ct type for the visualization of the projects

Enable help

Tool alignment according to TopSelid standard
I:l Measure the same offset points together

Group of tool components
WENDEPLATTEN
WENDEPLATTEN_2
WENDEPLATTEN_SPEZIAL

TopSolid



Cost centers

Cost centers can now include a description.

Cost center
Work with cost center

Cost centers Create cost center

2205|DMC200U  ~

Save cost center

What's New in TopSolid'ShopFloor 7.19

Description

DMC200U

Delete cost center

It is also possible to define specific cost centers for component storages, and assign them to individual storage

users for authorization.

i
Ca

STORAGE

Choose storage

WZAWorkholdings ~

Create storage

D For tool components

For workholdings
|:| For measuring equipmnets

Cost center

6683

Save storage
Delete storage
Create barcode PDF

Create .csv file on desktop

Login

Storage settings

Storage user
Juliz

Password
1111

Storage groups

Save storage group

Create storage user

Data matrix string
PERSOMN_ID=WLU

Create storage group

Delete storage group

Permitted storage groups

Permitted storage -
Permitted cost centers -~

2205[|DMC200U
2205|DMCE0

|| Allow manual drive

Save user

|| Storage supervisor

Delete user

ShopFloor users can now log in using a Data Matrix code, provided such a code is registered for the selected user.
This feature is automatically enabled whenever a Data Matrix is available.

= ShopFloor
User
Julia Wiss e E
Password
Leg in

TopSolid
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Interfaces

Kelch: Turret information transfer

In the Kelch interface, it is now possible to transfer turret-related information. This option can be selected in

Settings > Configure tool presetter > Kelch.

RS232/File

Zoller

File path

\\WIM-SRY-TSFO2\ShopFloor KELCH
Measuring program (Mill 1=W6&T1.par: Drill 2=W2T2.par:....)

Frasen 1=W6T1.par;Frisen 2=W6T2.par.Planfrisen 1=W3T1.parPlanfr

Measuring tolerance Z min. Measuring tolerance Z max.

-2.2 2.2
Measuring tolerance X(Y,R) min. Measuring tolerance X(Y.R) may
-0.22 0.22

Mapping tool holder (ex. SK40=1;HSK100=2;BT50=3)
HSK-AB3=HSK-A63;HSK-A100=H5K-A100;
Standard name for all machines

MSM

Offset tolerances can be adapted during measurement

| Transfer turret information |

Tool data transfer

#5T

$5n T34
$WZ T34
|#mw0 T34 (21 P10)

<
5 #WT Drehmeisel C5 C-Platte Alu
& #ME MSM

l
-
=
L]

8 #ME W1T1l.par
9 #MP 1
10 #G1 34.193
11 #G2 144.193
12 #01 34.413
13 #02 146.393

14 #01 33.973
15 #02 141.%993
16 #21 0

17 #R2 0

18 #5H 1

19 #EN

You can now generate one file per channel in the tool data transfer interface.

104

Login name FTPserver
Login password FTP server

D Load 150 files during providing

Channel| 1-4

Tool imp: E (per magazine separated by ;)

1_3.MP

ign header

1
2
Tool impp! 3
4

IWZG-DRT Liw von FDATE_TIME(dd. MM.ynyyy) 35

Tool import definition tool start

Create TS'SF folder on the machine

Delete TS'SF folder on the machine

El Send tool data of the measured tools in advance

Tool import file path (per magazine separated by ;)
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What's New in TopSolid'ShopFloor 7.19

Dashboard

The new dashboard offers an optimized overview of ISO files (available on the CNC and on the machine), as well as
tools for machine groups, individual machines and their magazines.

It displays all required tools, either for all ISO files or only for the selected file, specifying their status (on the
machine, in the magazine or for assembly). If an ISO file is not assigned to a magazine, you can consult the status of
tools in the various magazines to facilitate decision-making.

Additionally, the dashboard provides an overview of requested tools to be added. Tools can also be transferred
directly from the dashboard to interim storage or assembly.

£+ H (B

i
o
]
[}
2
2
=
=

) DASHBOARD _— = a x
~
> ISO FILES TOOLS TO ADD
—~ = = o A & - o
00 CNY (<) & [+ PROVIDED @ [-dMACHINE 3 )0 Te To %o FTe FTo to Tan Fao Ho L
3@ [@e . - = G i)
- & = v & =
= Q; 132 cnyDMG_DMU_S0@DI
1 <y X1000 cnyDMG_DMU_S0@DM_1 t 3 cnyDMG_DMU_S0@DM_1
= 0703202415145
DM_1 = - 2] CNYPROJECTS — —
\:, — ‘ t T34 cnyDMG_DMU_S0@DM_1 ‘ .
DM_2 O @100 @ i 32 enyDMG_DMU_50@DI
e D Chv.xioo ‘ 1 38 cnyDMG_DMU_SO@DM 1 ‘ 1203.2024-16:07 - Will neues
: oy @1 @ =
<cnyDMG_DMUS0_ECO ‘ 1‘ T300 enyDMG_DMU_S0@DM_1 ‘ ‘ fo 1 T2 CnyDMG_DMU_SO@DI‘
«enyDMG_DMUS0_LINEAR —
g ey _X1001 DMG_DMU_50@DM 2 o
‘g@(ny, cnyDMG_DMU_50@DM ‘ ‘ 1 Ti041 enyDMG_DMU_SO@DM 1 ‘ ‘ o "‘ T34 cnyDMGiDMUjO@DI‘
‘ (1, emy 1004 cnyDMG_DMU_50@DM_3 ‘ a o
L& 'EI' T8 enyDMG_DMU_S0@DM_1 ‘ {e 1‘ T38 cnyDMGiDMuiso@Dl‘
2 o [ 03 ‘ 1) emy x1002 cnyDMG_DMU_S0@DM2  12.03.2024-06:00 ‘ ‘ a e RS ‘ % s e
DM R vy cnyDMG_DMU
=
V2, ey X1004.test DMG_DMU_500? o
‘_ ‘cny_X1004_tes cnyDMG_DMU_S0@ ‘ ‘ t 855 nyDMG_DMU_S0@DM_1 ‘ ‘ %t s cnyDMG,DMu,so@DI‘
‘ 1‘ 132 cnyDMG_DMU_S0@DM_1 ‘ ‘ ﬁ, 1‘ T300 cnyDMG,DMu,so@m‘
‘ %e 1 Ta49 cnyDMG,DMU,SO@DI‘
‘ %ﬂ 1 T948 cnyDMG,DMU,SO@DI‘
‘ %e 1 Tio41 CnyDMG,DMU,SO@DI‘
2 03 (8
‘ Y "‘ Tio41 cnyDMG_DMU_SO@DI‘
‘ %e 1 T2278 cnyDMGiDMuiso@Dl‘
3 @ (g o

TopSolid 105



What's New in TopSolid'ShopFloor 7.19

Measuring Manager

The new Measuring Manager module provides a central platform for managing measuring equipment. You can
store detailed information such as descriptions, storage locations and statuses, as well as calibration data, including
due dates for the next required calibration. ISO files can now be linked to the corresponding measurement plans
and required equipment.

TO Soli (7= MEASURING EQUIPMEN ‘?‘ HT PARAMETER & INSTANCES ?&S CALIBRATED @ INFO

/ Limit plug gaugs 21457 Delete instance | m] i
@ - /30092024 Name: i pug gavge 01247
= Lt plug gauge O14HT 1 s rumoer

() Limit piug gauge G10HT

Description: Limit plug gauge @147

s " O08 Ikl ole PARAMETER Commant: Warkstattausfibrung
B | Cescription ame Manufacurer SATO0L
R . . P Manufacurer 3
PROJECT MANAGER (1) Limit plug gauge G12H7 Limit plug gauge G14HT @2 Limit plug gauge B14H7@1 Additional PN:
| comment o Description =

1 7% 9 i Crastion date: 27002004

Calibration interval in days: 60

@ PROGRAM MANAGER

Manufacturer

Comment

(&) Limit piug gauge 14HT Limit plug gauge O14HT @3

f TOOL MANAGER 1 102 Manufacturer BN 0¥ e
(1) Limit plug gauge 16HE Limit plug gauge BUHT@A auressz —
Additionsl PN
STORAGE MANAGER : N Data matri sting . -
o DY (O] D® [P p—p——r
-l Dstum
i TOOL SET Limit plug gauge BIZ7HE ) o Cabrated on
B 7% ® | Catibraton intervat in ays e B " A
® STOCK MANAGER (G|l pm———— .
Limit plug gauge 026+ =
supplier o
& WORKHOLDING MANAGER n DY an Coromant Files [+]
Name: Lim: plug gauge 9147 @1 ~ o
Sueul Technologis ans ol 5
@) Micromerer 0-22 80808080 Commant
MEASURING MANAGER -
— Location: QUIP0.3.5 2
w00 % Storsge: QUIPO 3.5 2@3@QUIPO
Edit / Information = Stock: 1
Creation asce: 27002024
Micrometer 0-25 Digital 7| [ |Crouon o rcnztze
o DY
S Calibrstea B
kS
&
g
g
5
o
2
2
2
[}
o
=
I“‘C] 929194-0P1#18# EETAE
Measuring plans _+ |—| Name ;'
| Measuring plan 1 Name ] pescription [] Parthumber
| Measuring plan 1
Comment T
i {=1 Caliper gauge 150mm 1 (&
| Messort {1 Caliper gauge 200mm |_7| v
MACHINE & {0 caliper gauge 300mm [ERORE

| Measuring Equipments
| {1 Caliper SVEN

Caliper gauge 150mm

0

{0 Limit plug gauge @10H7
Limit plug gauge @12H7

0

[0 Limit plug gauge @12H7

e ele
© e e

Micrometer 0-25 Digital

Ly

{1 Limit plug gauge @14HT

| [0 Limit plug gauge @16H8

Ly

[ Limit plug gauge @17.7H8

{00 Limit plug gauge @26H8

)

{0 Micrometer 0-22

L

[l

I =0 Micrometer 0-25 Digital
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What's New in TopSolid'Tooling 7.19

What's New in TopSolid'Tooling 7.19

Explore the latest enhancements in the Split (Block split), Mold, Electrode and Progress (Progressive die)
applications of TopSolid 7!

TopSolid'Split (Block split)

Candidate edges

The new Isoclines option in the Candidate Edges command calculates and imprints silhouette curves only on the
visible faces of the part, following the selected molding axis.

Example of searching for candidate edges in The Isoclines option automatically imprints
Precision mode. A closed path cannot be created the missing silhouette curves along the outer
due to the selection of unnecessary edges. contours, ensuring the creation of a closed path.

This feature eliminates the need to perform an imprint operation on the part before defining the parting edges.
Indeed, isocline imprinting generates numerous curves, many of which are not essential for parting line design. This
previously required the manual selection of relevant part faces to optimize the process.

Preview of the silhouette curves suggested by the imprint process for the same part.
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What's New in TopSolid'Tooling 7.19

Shadow curves

The new command 3D Sketch > Operations > Shadow Curves creates curves from a graphical analysis that
visualizes shadow areas on a part in a given direction.

Areas visible in the given direction, those in the opposite direction and undercuts are differentiated by specific
colors. The curves delimiting these areas, which do not already correspond to edges on the part, are then
generated.

i
i

i
|2

The part to be analyzed has The graphical analysis identifies the The curves delimiting these areas
undercut areas in a given direction. "invisible" areas in this direction. are then created in a 3D sketch.

Once the analysis is complete, the necessary curves can be imprinted on the part. This feature facilitates, for
example, the definition of parting edges for a moving insert in the split.

Parting edge creation wizard

The new Wizard command, available during parting edge creation via the special inputs icon i , provides an
intuitive way to define edge paths. You can select the next edge either graphically using an arrow or via keyboard
shortcuts, with the path being progressively built.

DFoIIowtangencies

Angular tolerance:

You can also customize keyboard shortcuts for the command's main arrows in the Parting Edges section in the
document options.
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What's New in TopSolid'Tooling 7.19
Shut-off surfaces
Enhancements to the Shut Off Surfaces command include reorganized dialog box and updated options:

» Edges mode: It is no longer necessary to select a reference face. Simply select an edge of a closed loop to
create the hole's shut-off surface.

* Shape mode: Improved edge loop search excludes the "outer" loop as a hole to be filled.

* Face mode: Shut-off surfaces connected to a supporting face are now created. You can choose to ignore
specific loops or select only the edge loops to be considered.
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What's New in TopSolid'Tooling 7.19

Split document options

In the Split Blocks document options, new settings are available under the Attributes > Molded Set section to
define the color of the shape with shrink generated by the block separation process. You now have the option to
choose a global color for the part and/or display or remove the colors of the part faces.

It is recommended to configure these options in a template document to automatically apply them in all future
studies.

Export with conversion

You can now export the shape to split from the Split Blocks document, while retaining the defined colors of the
molded areas. This feature facilitates client validations with clear identification of the insert zones.

To do so, you need to create a representation that includes this shape, and then export it in the parting stage.
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TopSolid'Mold

Non-synchronized design

The creation of a complex mold study often involves modeling a large number of parts, which can significantly
increase modeling and management time when these parts are synchronized in the mold document.

You can now work on a mold in a non-synchronized way with three new part inclusion modes, accessible in the
mold document options:

* Mold Base: The plates of the standard model are derived and included in the mold without synchronization.

* Core Cavity Blocks Inclusions The assembly parts from the block split document are derived and included in
the mold without synchronization.

* Mold Set Inclusions The parts from the injection or ejection assembly are derived and included in the mold
without synchronization.

To avoid synchronizing these parts in the mold, operations must be performed on parts edited in place or via the
assembly in non-synchronized mode.
Restoration of graphic selection

Previously, some parts included in the mold could lose their graphic selection, making it impossible to select them
when launching a command.

You can now restore the graphic selection of a part by right-clicking on it in the Parts folder of the Entities tree and
selecting the Restore Picking command.

Cooling circuit

Existing sketch

You can now choose to use an existing 2D or 3D sketch when creating a cooling circuit.

Double baffles

Double baffles can now be created in a cooling sketch. This feature enables the definition of two baffle lines and
automatically inserts two baffle components when the baffle line passes through two plates.

Two self-locking baffles are automatically

added when creating baffie lines. The lengths of the two holes are defined by the cooling style.
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What's New in TopSolid'Tooling 7.19

Cooling circuit style
The cooling circuit style now supports defining the two double baffle holes and their associated components.

The Round option allows you to adjust the depths of the baffle lines according to a defined step.

T Cooling Circuit Style O *

Round:
] |True w

23 .123
sil -15

Step:

0,5mm

Mode:

Mearest value

Drilling distribution wizard

The drilling distribution algorithm has been optimized to ensure a more uniform distribution across each interval.

=

ol

o

. . .10

.Zgﬁn_.
0

Version 7.18: The interval between the yellow hole Version 7.19: The holes are now evenly distributed within the

tha:ndtZZeIJIZ;Zﬁ\%ag égtivgglf tzg;;;i%{fggt;{n%nzgzs interval between the yellow hole and the element to be avoided.
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What's New in TopSolid'Tooling 7.19

For cases where hole distribution cannot meet all input data, several management modes for cooling parts are now
available:

* Strict: This mode displays errors and prevents validation of the dialog box until they are corrected.

i,

* Allow invalid drillings: This mode corresponds to the non-strict mode of version 7.18. Errors are not
displayed, validation of the dialog box is allowed, and the invalid holes are still created.
* Delete invalid drillings: Errors are not displayed, validation is allowed, but invalid holes are not created.

* Solve: Errors are automatically corrected.
i J%l
1

o

)

In the example above, a hole is placed in the middle of the two invalid
holes on the left (120mm), and no hole is placed on the right (200mm).

Baffle line distribution wizard

The baffle line distribution algorithm benefits from the same improvements as the drilling distribution.

Enhanced performance

The previously time-consuming calculation of cooling baffle depths over very large core-cavity block has been
considerably optimized.

233,26 B T Cooling Circuit

e wle o B

i " oo L il Tul s

[ B L | g " Rl

Calculation time before enhancement.

n

57.03] E 9 Cooling Circuit

TR | o o Tl

Example of a 75% reduction in calculation time. e— i el

Calculation time after enhancement.
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What's New in TopSolid'Tooling 7.19

Method

You can now define a method to automatically generate a cooling circuit. This feature allows you to quickly create
standard circuit parts, which are commonly shared across different molds, and then easily modify them to adapt

the final circuit to your specific needs.

The method automatically generates Once the circuit is created, it can be
the cooling circuit between two parts. adjusted to add any missing drillings.

Runner circuit
The Runner Circuit command features a new projection mode, Normal to shape, which allows the runner section
to be oriented perpendicular to the shape.

:

X

With the Normal to shape orientation mode, the circuit can

Previously, the sections were oriented by the mold opening
now follow all faces of a shape, regardless of their normals.

direction, sometimes limiting the precise positioning of the circuit.
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Gate

Hydraulic diameter

The hydraulic diameter is now automatically calculated at the injection point when including a gate. This diameter
value is displayed in the command dialog box, and it can be used as a parameter for later use.

®
Cer—

Computed saction:

232671 Terenl
Tranalation
O Gate

Ox )
O

(@)}

Increment:

0, i

sl e

Value

0. e
Hydraulic darmeter
1,72155mm

[ Create pararnetes
>

@

Pin

Method

You can now create a method for including "equipped" pins in a single operation. This feature allows you to define
common pin combinations based on your needs, and standardize them for future use.

nlniale

All components are automatically included

Example of @ method including a cylindrical and adjusted in the mold in a single operation.

pin and a tubular pin, with a precision plate.
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Angle pin

Component

The Angle Pin command includes a new mode, Angle pin retainer, which simplifies the positioning and

dimensioning of angle pins. The angle pin is automatically positioned and dimensioned based on the retainer
diameter, and its head is trimmed by the retainer. Only the length of the angle pin can be adjusted to control the

desired stroke value.

Angle pin pocket

Angle pin pocket positioning

=

Previously, the angle pin pocket section was automatically centered around the selected angle pin. Now, you can
define the position of the sketch center from a frame, such as the mold origin, and round off the distance between

this frame and the sketch center.

116

() User
-«
© Model
| ¢+ Oblong ~

Code:

[] Automatic frame

Reference frame:

A | Absolute Fram - | db

8 Automatic distance

&0mm

Reunding:

Superior (1) x
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Angle pin pocket dimensions

What's New in TopSolid'Tooling 7.19

You can now create angle pin pockets using rounded dimensions, thanks to an option available in both of the
sections below. To activate this feature, check the Automatic box.

* Drivers: The minimum driver values are automatically associated with the sketch drivers, with the option to

round them off.

)

@ sutomatic

Drivers

Width:

10mm

Width Clearance:
Tmm

Length:

32mm

Length Clrearance:

1mm

Rounding:

Superior (1) x

* Depth: The minimum depth is automatically detected and can be rounded off if required.

Method

DThrough

() Offset

© Depth

B Automatic
23,150823mm

Rounding:
Superior (Precision = 1) x

You can now create a method to include angle pins and their pockets. This feature enables the design of
standardized movement assemblies, including various components such as slides or angle pin retainers. The
associated processes and the angle pin pocket are also automatically applied when using the method, optimizing

the design process.

TopSolid
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What's New in TopSolid'Tooling 7.19

Marking

The Pins Marking and Drillings Marking commands have been optimized to improve the legibility of markings on
3D parts.

A new advanced option, Color, now lets you assign a color to the edges generated by the marking operation or to
the sketch of the lightened marking, making them easier to identify.

Pin marking

A new advanced option, Automatic positioning, automatically fills in the radius and angle values required to
position the text on the plate. These values are automatically calculated based on the selected pin diameter and its

keying orientation.

=0
& . D

@Y ©
)

Drilling marking

A new option allows you to mark the tapping description (e.g., M6, G1/4, etc.) when the selected hole is tapped. This
marking is associative with the tapping performed.

Text

Text to mark:

IHTapping description
M7

Family:

& Arial o

Drivers

Size:

A

In addition, the advanced Automatic positioning option automatically fills in the radius value for positioning the
text on the plate based on the selected hole diameter.
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TopSolid'Electrode

Electrode frames

What's New in TopSolid'Tooling 7.19

Previously, the machining and machining positioning frames, automatically defined during electrode creation, were
rotated 180° around the X axis of the electrode base frame.

You can now choose to rotate the base frame around its X or Y axis.

Decorrelation

e Frames Creations Management

Machining frame

Base top frame 4

Pivoted around:
() X axis
0O Y axis

Machining positicning frame

Mandrel frame ~

Default frame if no mandrel:

Base top frame ~

Pivoted around:
() X axis
0 ¥ axis

EDM frame

Base top frame 4

The Decorrelate command, which was previously only available in Assembly or Mold documents, can now be used

in an Electrodes document.

This allows you to decorrelate synchronized parts directly from the Synchronized folder in the Entities tree. In
addition, operations created in the Electrodes document are now rebuilt in part documents, without any link to the

Electrodes document.

TopSolid

# 9 Parameters
P Styles

= Synchronize...

Synchronized
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What's New in TopSolid'Tooling 7.19

TopSolid'Progress (Progressive die)

Restoration of graphic selection

Previously, some parts included in the progressive die could lose their graphic selection, making it impossible to
select them when launching a command.

You can now restore the graphic selection of a part by right-clicking on it in the Parts folder of the Entities tree and
selecting the Restore Picking command.

Decorrelation

The Decorrelate command, which was previously only available in Assembly or Mold documents, can now be used
in a Progressive Die document.

This allows you to decorrelate synchronized parts directly from the Synchronized folder in the Entities tree. In
addition, operations created in the Progressive Die document are now rebuilt in part documents, without any link
to the Progressive Die document.

# €[ Parameters

B P Styles
BR8] Synchronized

Hiding components

A new Hide Components command, available in a drafting document, allows you to hide a component and its
associated process on a projected view. Additionally, missing hatching is automatically rebuilt to ensure correct
representation.

In the example above, several The section view can be lightened by hiding
components are symmetrically placed. these components and their process.
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Explore the latest innovations in TopSolid'Cut, TopSolid 7's cutting software for the sheet metal industry!

Cutting

Multiple sheet metal machining

A new Machinings contextual command is available in the project tree, enabling quick creation of multiple sheet

metal machining operations.

ol 3 chapa metalica

E% Y ese-02
E% Yese-03
& T R
& T [N
#3 lens plated v
& %= pART4

% % Partl

% % Partl

4 B part?

=, Machinings...

F 5= Piecel 1
#3 sample 1

% B Sheet metal
#3 sheet metal
#3 sheet metal -
#3 sheet metal 3
#3 sheet metal 4
#3 sheet metal §
#3 sheet metal §
#3 sheet metal §

] e

Open Document

Consult Document

Properties...

Work Manager
Multiple Print

Sheet metal machining

Update...
Check In...
Deletion

Cut
Copy
Import / Export

Library Design

What's New in TopSolid'Cut 7.19

% B Sheet metal

This command allows you to select only unfolding documents, and works in a similar way to sheet metal machining
processing. Simply configure the dialog box by selecting the desired template and confirm.

=) Machinings o x
| i
S |

4 |Material Comments

Existing machinings

ESB-02 OptitomeV2 1530

= ESB03 Acier 1. 3mm
=] ESB04 Acier 1,2mm |
= ESMF-02 Acier 1,2mm |
|- Template |
|
|
|
Destination !
|
) Source folder |

O Specified folder: Projects\7.19

Options
|
8 Create machinings
[ Create micro tabs

[ Open after creation

% ?

In the example above, three sheet metal machining operations will be created as machining already exists for the first unfolded part.
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Link machining

It is now possible to machine a link. This option is accessible from the Link tab in a cutting operation and is
compatible with the following operations:

 Cutting

» Center punching
* Waste cutting

* Skeleton cutting
» Common cutting

- | =S | 88 v

" Links :
X R ?
Head state r'/l Head up

Head state (micro tab) " Head down

b Smooth links

Mode }6 Deactivated

!, Dangerous links resolution

Resolution type & MNone
 Machining /
i Vizchine link

“¢r Evacuation

OLBEOIOQ®

Evacuation type & MNone

This feature can also be selected by right-clicking on a compatible link.

\ 4

—

-

Link
4 Edit
Delete
Head down
i Machine link

Passing point
L Edit

Evacuation
& Add machine stop

Cad 3
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Machining propagation

The Cutting tab features a new Propagate command, which lets you select a part, contour or machining operation,
then propagate it to all similar parts.

8 Home | Equipment ¥ =@Management ¥ = Cutting + [ Nesting + | =i Additional & ¥ Operation & “Verify 48

| 228 BM ¢V EHDE TS OSITTHEEE | W

Propagate Start Page |47 2"
[+ Selection _ 2
: X &7
Mode ¥ Part
i, Propagation
Mode EE Similar rotations

Supported machining types include:
 Cutting
* Center punching
* On the fly cutting

* Micro tabs
* Geometry to skip

F K
HHXK

In this example, the machining operations have been propagated from the bottom right-hand part to all identical parts.
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Prototype parts

A new Prototype parts tab is available in the Automatic Machinings command, allowing you to select parts to be
excluded from the overall machining path and machined first.

Parts “9)\(?@ ?

\;

b: Select one from each

Machine stop l;:] Only once at the end

LWOBODOOOOV

Parts can be selected individually or via the Select one from each button, which automatically picks one part of
each type. A stop is applied either after machining each prototype part or upon completion of all prototype parts.

Start Page |47 2*
v K ?

Parts

Forme mise 3 plat <1334>
Forme mise 3 plat <1552>

Forme mise 3 plat <1657>
Forme mise 3 plat <1134>
Forme mise & plat <1381>

I [a Select one from each I

Machine stap ' og] Only once at the end

LOEBOBOLe®

00000000000
000nngonou

Additionally, prototype part tool paths are previewed separately from the main tool path.
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Heat management

The Automatic Machinings command features a new Alternate option, allowing you to define the number of

passes to reduce heat concentration on a specific sheet metal area.

- Machinings
RNV o

I3 Selection

W An

Selection Type

- & Profiles path optimization
Sequence . Part by part
Start Bottom left

Progression direction  ** Horizontal

f£ s with neighborho

x None

[ Recalculate current links,
@ Altenate /

Strategy

Machinings priority

Paths count
i |

-''% On profile start point location

Hooking @ Picking
E Internals

Circles (3 optimized
Oblongs () optimized
Rectangles [ optimized
Other contours % Optimized

[C) Fecus on corners

v K ?

LOBOOOLO

The tool path alternates between machining passes and skipping an equal number of operations, as specified, to

prevent overheating the same zone.

TopSolid
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Example with 1 pass.

Example with 2 passes.
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Ignored geometry

The new Geometry to Skip command in the Cutting tab lets you exclude a contour or a portion of a contour from
machining.

5 Home -0 Equipment ¥ <@ Management ¥ =i Cutting ¥ [ Mesting ¥ =i Additicnal ¥ %HOperation & “§iVerify |4
)i L ; ial fal X =0 0
b | A e < \‘:/b '4-*@{:‘;‘;.‘". \/"?H#EI )(
-] Geome 0 p Start Page |4 1*
[,} Selection 2
-
Geometry
Start point @ Picking
Contour Type S—ﬂ Complete

By default, ignored geometry is represented by black dotted lines, but the color can be customized via Tools >
Options > CAM Options > Sheet Metal Cam Options > Machining Attributes.

This option is also available in automatic machining, although it is not possible to simultaneously generate
machining operations and geometries to be ignored.

You can set the geometries to be ignored in the Cut Technology document, under the Geometry tab, by filling in
the Technology column.

| Cutting conditicns || Geometry || Leads ” Corners precessing || Speed ramps ” Drilling |

Contour Type Threshold length Technelogy
External conto... = | Omm Cut small conto... -
External conto... = [Z20mm Cut wide contour -
Printed contour = Omm Marking <

4 Bending line = | Omm Geometry to skip R
Internal contour = Omm Cut small contour
Internal contour = | 20mm gﬂ:trﬂ?dge contour

< Geometry to skip
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Optical tracking

The new Optical Tracking command in the Cutting tab enables compatible machines to verify sheet squareness by
analyzing specific geometries before machining.

'ﬁw.rify I-IE

%¥ Operation =
Fo=m pe=g n=='="a n=='="a r
ﬂ

u===a N Th T

£ Home ‘-',Equipmeni =|=ﬁlu|an.agemeni =|£Cuﬂing ;‘ENEI‘.II‘Q L ﬁﬂdditbnal -

+ & SEHEIV VL

2 Geometry

Tracking mode * Creation @

- dp Creation

T

E::dl

X coordinate |‘l’ coordinate

&P ¥ &

Tracking gecmetry 0 Circle

Diameter

10mm

Tracking area D Bottom Left

You can use existing geometries or create new ones as needed.

7
Tracking mode #F Creation léx °
&k Creation
X coordinate Y coordinate &k
1800mm 100mm x
1900mm 100mm
. 1900mm 200mm £
[ | ]
¥ OoO00do0n Oo(oooo OO0000
Dooodoog Oofcooo Doo0dod
OOoO0000n OO0 ooo 000000
Oooo0ooo ooflocooo Dooo0od
S @® s CoO00000 Oolco oo 000000
) CO00000 Ooflcooa OO0 000
Diameter COO00000 O olc 000 GO0 000
10mm CO00000 O Oolc o000 COO0000
Tracking ares [ Battom Left
[ ] [ ]
OoO00000 Oo(0oooo00o0o OO0000
DoO00ogg Ooloooooooo DO000d
OoO00000 Oo(0oooo00o0o OO00 00
0000000 Oofloooo 00000 O *
CLO00000 Oolco oo CO0000 :
CO00000 O oflc oo OO 0000 0
G000 000 O oflc oo 000000 Lee =
CE L ) ahellel s a8 LR )

To use this feature, the following conditions must be met:

* The document must be in For ISO code generation mode.
* The selected machine must support optical tracking.
* A sheet metal format must be defined.
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The Optical tracking option can be activated in the machine document via the Machine Setting command in the
Sheet Metal tab.

B Home P Assembly 5 FsModeling 5 b Mechanism 5 | # 2DSketch & # 2DSketch ¥ mMlVisualization ¥ < Machine ¥ | J7SheetMetal ¥ TP Analysis ¥ | " Construction ¥  {Tools ¥

= | B < nﬁmw a

v X ?

HOpticaItracking

Pattern managerment type:

MNone

Multiple edit filter

A new filter is now available in multiple edit commands, allowing only internal or external machining operations to
be selected.

[+ Selection

Reference machining

| e

B D] —

Machinings

[ i1} Settings
Force Micro Tak Width

0,2 mm
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What's New in TopSolid'Cut 7.19

Evacuation editing

The new Edit Evacuations command in the Cutting tab provides several practical options:
5 Home -8 Equipment ¥ <@ Management & =i Cutting ¥ |[ Nesting & #Addiﬁunal - }ﬂDperatiDn ¥ | foverity B
| LiESE| X

%3 I % DE;'[ d}\vr“ﬁ" iy ,;“ H : AT

«qi-— A g <l

* Add a machine stop to all selected machined parts.
[+ Selection VRV l"'. ?

Reference machining

Machinings

_

] =< Evacuation
Evacuation type @ Machine stop ﬁ

v

* Apply an existing chute door from one cut to another.
Iy Selection v X Jn‘ ?

Reference machining

|Cutting

Machinings

] “r Evacuation |
i B D-"-"-"----"-"-"-"- '
Evacuation type v Chute door
M Settings

Configuration

=)

Er
—
Q
=
=
><
v
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Lead editing

What's New in TopSolid'Cut 7.19

The Edit Leads command now includes an option to select only operations with collisions.

Lead formulas

You can now assign multiple formulas to the same lead, allowing different formulas to be applied depending on

[+ Selection

Reference machining

=]
=1 =

[ Cnly operations with lead collidings

Machinings

»

whether the lead is used on a line or an arc.

TopSolid

= Standard leads

Lead models >

|

- X2

Lo®

L45%
Loo®
A45°L0°
AgQ®LO®
AgQeL10®
AgQ®L30°
Ad5®
AQD®

AL

Leads =

I
L5(0.5xL)
L5(2xT)

- X o

.» Lead model
MName:
Lo®
' Lead
MName:
L5(R)
[ Lead to center
Limnit radius:

10mm

“~" Lead elements

Preview >

/1> Line

Accosting angle:
0

Length:

Smm

Length (by formulz) on a line:

«~

Length (by formulz]) on an arc: /

R

|
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Work

Process cancellation

You can now cancel a process in progress in the work document by simply pressing the Esc key or clicking on the
red cross at the bottom of the screen.

|'ﬁ Work H@ Processes H Results H',_/ Review |

Selections Configuration
Available processes: Processes to apply: MName:
TopSelid'Cam |Unf0|dings1 |
TopSelid' Cam SheetMetal SheetMetal Cam (TopSol m SheetMetal) (SheetMetal Ci
TopSelid'Design Nestings (TopSolid'Cam SheetMetal) (Nestings 1) Descoption:

TopSelid'Drafting
TopSelid'Interop
TopSelid'Interop Acrobat Decuments to consider:
TopSclid'Interop AutoCAD

Creates unfoldings from of a set of parts. ‘

g

TopSolid'Interop Fix :"*' Document Type Qrigin Processes
TopSelid'Interop Ifc T Part Task -
TopSolid'Interop Spatial t | Bill of Material Task -

TopSelid' WorkManager

Crested documents:

Document Type Template Destination Folder|
<unspecifieds Specified folder = | /Trav

Executions
L 2 ‘:{\ Advanced Configuration...
Process State Result Messages Duration
Unfold the cccurrences = No a
Unfoldings (TopSolid'Design) (Unfoldings 1) Executed | Suc 148
SheetMetal Cam (TopSolid'Cam SheetMetal) (SheetM... | Executed 469
Nestings (TopSelid'Cam SheetMetal) (Mestings 1)
v
Pause after execution
) R—
spSolid'Cam SheetMetal) (Nestings 1) ] #  X=+000,000 Y=+000,000 Z=-+000,000
A confirmation message will appear after any of these actions.
+/ TopSalid *

7 Do you really want to interrupt nesting computation 7
L]
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What's New in TopSolid'Cut 7.19
Work Manager

The Turn Support contextual command is now available in the Supports tab of the Work Manager, allowing you to
apply a rotation to the selected support.

This feature is only available for supports that are not derived from a family.

Work Manager (Project = Work Manager 2)

EEED : | ?
= el Hl? e Hﬁ Works ‘

ETH

Document (1/6) State Description

[ Wsupport téle - 2000 x 1000 » 3 | Up to date | Support tale - 2000 x 1000 x 2

‘Some lines are hidden by filters
Drop a Family or Part document fram project tree to create a support.

3 18 Name Contains '7"

i Turn support O x

Rotation angle:

o

Support before rotation Support after 90° rotation

W
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What's New in TopSolid'Inspection 7.19

Discover the latest features in TopSolid'Inspection, TopSolid 7's quality control software!

Process

Multi-drawing management
You can now capture dimensions from multiple part drawing files.

This feature allows the integration of files in various file formats and structures, with the use of multiple tabs to
efficiently manage your entire inspection project.

Drawings Version control

-+ Index | Drawing name File Image
'o 1 20130409 _094444 D:\07 - PLANSY20130409_094444, pdf W
" v 2 iB10292770-2208 D:\07 - PLANS\B 10292770-220E-X.PDF
n' 3 FRAISAGE D:\07 - PLANS\FRAISAGE. dxf
Lz
. ) 1 |of1 @ & Q- & ™
]
PricHy
T Prasz
e . 27 sopowda aur 3150
= i v J‘ 1 ouEE Ak
~ P L o ] o {/% | g
A= N7 yy 1 / ” | )
& || ]
7. é XA, " A”;g -
!ﬂij !1.:
Pz B

Ot dz la medifizstion c.-gr=| Culz I'.'m

Demsignation :
C 40 DE GH1320 1.4435
{316L)
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Version management

Track your project’s lifecycle with ease. In line with the new ISO standard, any updates to an Inspection project are

now automatically versioned. Each save in TopSolid'Inspection or any action within TopSolid'Erp automatically
increments the version number, whether for a major or minor revision.

Drawings Wersion control

+
Revision Date User Action Comments
1.0 6/4/2024 3:50: . Test Création du projet | Email 02/01/2024 "
11 6/4/2024 4:01:... | Test Sauvegarde Creator
1.2 6/4/2024 4:01:... | Test Sauvegarde Creator
1.3 6/4/2024 4:04: ... | Test Sauvegarde Creator
1.4 6/4/2024 4:07: . Test Sauvegarde Contraller
1.5 6/4/2024 4:09: Test Sauvegarde Controller  Phase P-10
16 6/4/20244:10: . Test Sauvegarde Controller  Phase P-10; P-20
3 1.7 6/4/2024 4:13:... Test Saveas
1.8 6/4/20244:16: . Test Sauvegarde Contraller  Saveas - Phase P-10; P-20
2.0 6/6(2024 11:42 .. | Test Incrément version maje... | Major version
21 6/6(2024 11:42 .. | Test Sauvegarde Creator
2.2 6/6/2024 11:43... | Test Sauvegarde Creator
23 6/6/2024 11:43... | Test Sauvegarde Creator
2.4 6/6/2024 11:43... | Test Sauvegarde Creator
2.5 6/6/2024 11:43... | Test Sauvegarde Creator
26 6/6/2024 11:43... | Test Sauvegarde Creator
27 6/6/2024 11:43... | Test Sauvegarde Creator
2.8 6/6/2024 11:43... | Test Sauvegarde Creator
29 6/6/2024 11:43... | Test Sauvegarde Creator
210  6/6f2024 11:43... | Test Sauvegarde Creator
211 6/6f2024 11:43... | Test Sauvegarde Creator
212 6/6f2024 11:44... | Test Sauvegarde Creator
213 6/6f2024 11:44.._ | Test Sauvegarde Creator
2.14  6/6f2024 11:44.. | Test Sauvegarde Creator
2.15  6/6f2024 11:44.._ | Test Sauvegarde Creator
2.16  6/6f2024 11:44... | Controleur Sauvegarde Creator
2,17 6i6/2024 11:44... | Controleur Sauveaarde Creator hs

Adding checkpoints in Controller

This new feature improves workshop flexibility. During measurement sessions in Controller, you can now directly
interact with parts or checkpoints. You can add characteristics to be inspected on all or a specific selection of parts,

include additional parts for inspection, or adjust existing characteristics.

v Part [ Checkpoint management - o x
XV
_—
Close  Validate
Action
‘ Target: Part ® ) Checkpoint
| Action: Add existing checkpaint ® Add new chedpoint Edit checkpoint
Rule: According to the frequency # On selected parts

The checkpaint wil be added to the selected parts.
|

Checkpoint values
Ne.. T Sttut T Commentsires
GDT Value: Fit:
: Lower tol.: Upper tol.: =+ 1 [l -
|| Low, value: Aver, value : Upper tol.: + 2 =
Warning limits: - |Low.: Upp.: + 3 =
Comments : * 4 =
+ 5 =)
Checkpoint properties 4 P =
Phase: + 7 =
Acronym: - | nit: 4 I —
| Equipment 1: + 9 =
Equipment 2: + 10 =
| | Equipment 3: + 11 =
Equipment 4 + 12 =
| Control type + 13 =
T + 14 =
Treatment: + 13 L
Texte 1 Texte 2 + 18 =] i
|| Liste 1 - Liste 2 + 17 =
Image 1: ~ | Image 2: + 12 = I
+ 1% =

V Insert . oo
— .

T LU e
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What's New in TopSolid'Inspection 7.19

Voluntary project locking

You can lock a project to close it or restrict access to authorized persons only, enhancing project security and
control.

7 Lock management - 0O x

\/ = 72 + N
— ﬂﬂ] u — "
Validate Delete  Refresh | Addlock Editlock

Actions Lacks Valuntary locks

Functional locks | Voluntary locks

Find
d Lock type ML file Date User Shared owners Comments
] 61614844 En construction D:\07 - PLANSNTLY 10600034600 23/08/2024 15:3_ userMr Admin user2iMr Gestionnaire:
61614844 Cloturé D:AD7 - PLAMSNITLY _ _10292785-220E-X OFA5643_ | 23/08/2024 15:4 useriMr Admin user3|Mr Constructeur clot
41609576 En construction D:ADT - PLAMSNITLY - 'ROGD00346002 sa_ | 23/08/2024 15:4_ useriMr Admin
41609576 Cbzoléte D07 - PLANSNTL 46002 itl 23/08/2024 15:4_ | user2IMr Gestionnaire analystiTest aa
41609976 En construction D:\D7 - PLANSNTLY 106000346002 1 23/08/2024 15:5_ | user2IMr Gestionnaire: controleiControleur
41605576 En construction DAD7 - PLANSMTLY 500034 23/08/2024 15:5_ | user2IMr Gestionnaire controleiControleur

Non-conformance management

Take scrap parts into account with new non-conformance management features. If a part has a non-conforming
dimension, it can now be rejected. Additionally, for sampling frequencies, non-conformity of one dimension can
trigger measurement on the next part.

oon style v | () Image

veral tol.: IS0 2768-m v

sject created the: 4/15/2024

Warning E3 / /V 7/‘ I
1

|, Non-conformity: the checkpoint must be inspected on the next part. 1.6 A

wdifier: Test

vision: 4/15/2024

‘reation view: list of checkpoints

+ View Link Phase I.~| .. B..| SecondaryNo| Location _ | Acronym Value  U.. Upp.. Low.. Upp..| Avera.. Low.. Equpm.. |Equipment2 Equipment3  Equipment4 | Contro.. Frequ... Parts.. | Fit Treatment
I'.T [RE=] 1 B 3 20 mm 020_|-020_ 202 20.0000 198 Ech.5 n (3]
3 %  Measure... Part # Controlled value OK { NOK Status Comments User Measure ... | Instrument 1 | Instrument 2 | Instrument 3 | Instrument 4

E » 1 1 200 = Test 4/15/202 L]

i 2 6 pal L=} Mr Admin 9/25/202

En 3 7 =

n 4 I8 m Vi Adimin

& 5 18 = Mr Admin

Distributed percentage frequency

A new checkpoint frequency type allows you to distribute a defined percentage of parts for inspection across the
entire series, ensuring optimal adherence to sampling frequencies.

Deleting checkpoints without renumbering

This new feature streamlines project reuse by allowing you to delete a checkpoint without automatically
renumbering the balloons.
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Usability

Balloon style

What's New in TopSolid'Inspection 7.19

To simplify balloon formatting, display options such as color, shape and transparency are now grouped into
customizable styles, accessible with a single click from the project or label formatting window.

1%/ Balloon style

v X

Validate Cancel

Actions
Label

Balloon shape:
Label size

| Display box
Use as line color in grids
Font
Font:
v Bold

Italic

Secondary balloons
®) Alphabetic index

Numeric index

- - KX

Red round|
‘] Circular v | Transparency: | Semi-transparent + | Color | N 240,0,0 W
n
L
Display link
Cambria Y]
Underline
Strikeout

Mumber [ Secondary separator | w*| Display box for secondary balloons

GG s..

Display format w | || Display link for secondary balloons

Non-conformance summary

This feature prints out a color-coded drawing for each part, highlighting the conformity of dimensions and providing
a clear and quick overview of non-conformities.

7
X 13 g

Close Print. Print
current all

Number of compliant parts: 8

Project summary -

Number of defect parts: 3
Number of defect checkpoints: 5 Chedponts ] [EF] B rer= 5] EE] B
Number of NC declaration o
Part # Status Comments Serial # NC

1 = TOP-180.CX ~
v 2 = | TOP-181CX

3 = TOP-182CX

4 = TOP-183CX

5 = TOP-184CX

6 =] TOP-185.CX

7 =

TOP-186CX

100 7
| E— ;
I@ H
i 0.1[A]
2 | - [
4 5 5 Tﬁ .
. 20 20 A
I o~ @ 1.6 -
o
NAN f%
I . v Ii—v ¥
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What's New in TopSolid'Inspection 7.19

DXF drawing display in Controller

The Controller application now makes it easy to display digital drawings in DXF or DWG format.

" TopSolid'Inspection Controler 7.19.303.0 - User:Mr Admin - a X

Project - FRAISAGE - V0.1 = FRATSAGE. dxf

Client : Cde : OF : < =

wer. e o COUVERELBREF §782

Designi : LR SIENES o

o=l X | M5 15
Code phase : Libellé phase : Machine : 1 QG
rigin
Piéce Phase Bulle ;
PR -
1 - —
- @ 1y

Commentaires pidce : —

Valeur attendue 70
sige : Unté: mm | Fréquence : 7 3 TROUS M8

O ey e P e PROF 10MM \@
[ 0 [ | SUR DIAM 60 <
‘ 0.5 0.5 189.5 190 i 190.5

Control type [

Texte 1 Texte 2 Liste 1 Liste 2
Instrument 1: | - |Instrument2: ~ Instrument3: ~ Instrument4: ~ N°prog.:
L a0 ke /O

0K NOK | 4.m Statut : = 4 trous dlam 85

*
i @) L
Texte 1 Texte 2 Liste 1 ~ |Liste 2
192
( ot 200
= N

Complex geometric tolerances

The functionality for entering ISO GPS geometric tolerances (GD&T) has been enhanced, enabling more precise
management of complex tolerances in your projects.

IUse new secondary index

Acronym: ¥ | Tal.: 150 2768-m W
A GOT -IS0 GPS
|e vlﬁ vl D.1|®I vl vl A | vl B |® vl c |F v|

Cancel Validate (3)

Single balloon for secondary indexing

Customize the layout of your ballooned drawings. When duplicating a balloon with indexing, only one balloon will
be displayed, simplifying the organization of information on the drawing.

Disabling graphic animation

You can now disable graphic animations in Creator and Controller, optimizing display performance.

138 TopSolid



Import

CMM import from Controller

It is now possible to import results directly from the workshop station. Controller supports importing external

What's New in TopSolid'Inspection 7.19

reports, allowing for additional properties to be filled in during the import process.

-
Project - Demo P RO600 0346 002 - V1.0
Client : THIRARD Cde : OF:
Réf. : TH1232 Ind:a Qte:
Design1 :
Codephase: | P-10 Libelé phase s | Phase © | Mad

Pigce P-10 Bulle

1 -
1 -
TH500

Commentaires piéce :

Valeur attendue

Sigle : | L Unité : | mm Fréque
Moyen1:|.. =~ |Moyenz: - |Moyen 3:

‘ 2,50

‘ 0.1 0.1 2.8

Texte 1 Texte 2 Liste 1 Liste 2
Instrument 1: | - |Instrument2:| - | Instrument 3

oK * NOK | ‘ ‘ +..

Commentaires : | reztret ertret

Texte 1 Texte 2 Liste 1
32
3.1
< N
28 L—/
3w —
0 1 2 3 4 5

Location on CAD import

L Import | Export

X

validate Cancel

Actions

Paramétres dimportation
Modgle de correspandance : Calypso
Fichiers de résultats 3 importer

Browse La structure des fichiers doit tre identique.

Files

—  D:\07 - PLANS\ITLTRIDIM\P039945 ind B OP190 final_OF 50738 N°2190-SE49477.xdsx
D:107 - PLANS\ITLTRIDIM\P039245 ind B OP 190 final_OF 90738 N°2190-5E49478.Xlsx
D:\07 - PLANSVITLYTRIDIM\P039945 ind B OP 190 final_OF 50738 N*2190-5E49480.xisx
D:107 - PLANS\ITL\TRIDIM\P039945 ind B OP 190 final_OF 90738 N°2190-SE49482.xIsx
D:\07 - PLANS\ITLTRIDIM\P039345 ind B OP 130 final_OF 50738 N°2190-5E43483.xIsx
D:107 - PLANSVITLYTRIDIM\P039945 ind B OP 190 final_OF 50738 N*2190-5E49484.xisx

D:107 - PLANS\ITL\TRIDIM\P039945 ind B OP 190 final_OF 90738 N°2190-SE49485.xlsx

Record 1of 7 ¢ 1w —

[

- o x
1o P RO600 0346 002. .. ~
Réw. B Descrph
5 [1ai092020| o ozt
A | zsiens

INOX 3041

b

When creating a project from a TopSolid'Design drawing, you can easily locate the balloons and automatically focus
on the dimension to be inspected.

CMM import by balloon number

A new feature allows you to import CMM reports using the part's balloon number and serial number, instead of

balloon index and part index. This ensures greater compatibility with various import formats.
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What's New in TopSolid'PartCosting 7.19

Discover the latest features of TopSolid’PartCosting, TopSolid 7's part costing software for manufacturing!

Performance

Part search by material dimensions

Easily identify similar parts based on their material characteristics to optimize analogy-based cost estimation. The
multi-criteria search window now lets you filter by material dimensions.

™ Partsearch o @ =
—
Validate Cancel
Actions
o BEGEE © FErEiEE e Tl e sy e Enter text to s=a Find
S o u Image  |Modfication ... = | Code |ReferenceMo. | Desaiption Re
v Perpart: » J 10/10/2023 123
A permatenia: p
i’ 4f6/2022 859542385
Materil oroup:
Find
bEmzs é/ 2/21/2022 B69542385 CYLINDRE 14/40 K456 A
> S Aders aliés v Per manufacturing -
> [ Aders dcoletage J 2/21/2022 869542385 CYLINDRE 14/40 K456 A
s = Acers doux ~ Per procurement
> i Aders inoxydables N p
. 4 11/5/2021 869542385
> i Aders non aliés — r
[ e eeReHG=
> i Bronze J 10/12/2021 869542355 CYLINDRE 1440 K456
> iy Cuivre out, Diameter mm): |40 usedlength (om): 100 | Tolerance (%) [ 10 -
4 Fonte l 8/25/2021 B69542385 Cylindre 14/40 1
FONTE 2 @
I y 7/13/2021 569542385 5
> i Plastiques techniques [
» i Titane
Poubelle J 6/10/2021 869542385 CYLINDRE 14/40 K456
J 4/13/2021 869542385
% 4f9/2021 123
e/ 4f8/2021 863542385 Cyindre
@/ 32572021 GHas632
” 17/2021 B69542385
J 1211772020 Exemple123
¥ 11/27/2020 869542385 CYLINDER 14/40
+ Per machine: E
v Per subcontracting E/ 10/29/2020 DF456 Moyeu
v Percase
Noimagedata  3/23/2020 Exa5632 Ensemble
v Perprice
4 6/22/2020 B5043965-56 o
44 4 Record1of22 b W M
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What's New in TopSolid'PartCosting 7.19

Usability

Configurable time unit and rounding

Customize the calculation time unit to align with your business needs. Cycle times can be displayed in hours,

minutes or seconds, with rounding adjustments according to your specifications.

Operation plan 1 x
Material | Operation plan | Supplies

Series type N &
© First series ©) Stablized series Mo Ny
+ Index | Workstation Machine Cyde | Adi. | Prog. | Status
A |v| 1 Miljwm Reftournage/f.. 3.5 0450 Ou2  EW
[} 2 Sub-contracting 00:00 =
L

8

B

A

&eyde | MEad. /Prog.

o In.. | %Pha._ | Description Time |Qua.. |Totalti | Status Op
. | 1 15% Spndemoveme.. & 1 3

= 2 21% Proflext -Eba.. 8.2 1 82 = o
- 3 3% Fietageext. 126 1 126 o
@ 4 15%  Counter-spindle 6 1 ]

k 5 17% Trongonnage 6.7 i 6.7 = ~
E; 6 0%  Troutarsudé (x1) 24 1 24 L Fped
o
a

Phase total

Calculated time 0 = =S

Process

Batch quantity

Optimize manufacturing by defining the quantity per batch. The quantity per batch is added to the total number of

parts to be supplied. Implementation times are now calculated for each batch, rather than for the whole series.

Customer: |TOPSOLID SAS e | * Search Case: 90 - AF456 Search  Deadline:
Enter text to se: Find -
Code: A Part No.: TOPE557452 * Oty 50000
-3 N N
> P& Classification Description: Revision:

TEMPLATES )

TopSoidERP Element index: (] Equipment  Element description: Element Qty:

TALIA Total element time

D200211 Unitary: 00:00:43 Series: 552:06
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